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Utiliser LibreOffice sur un Mac

Sur Mac, certaines touches et certains éléments de menu sont différents de ceux utilisés sous 
Windows ou Linux. Le tableau ci-dessous donne quelques substitutions courantes pour les instruc-
tions de ce chapitre. Pour une liste plus détaillée, voyez l’Aide de l’application.

Windows ou Linux Équivalent Mac Effet

Sélection du menu 
Outils > Options

LibreOffice > Préférences Accès aux options de configuration

Clic droit Control+clic ou clic 
droit selon la configuration 
de l’ordinateur

Ouvre un menu contextuel

Ctrl (Control)  ⌘ (Command) Utilisé avec d’autres touches

F5 Shift+⌘+F5 Ouvre le Navigateur

F11 ⌘+T Ouvre la fenêtre Styles et Formatage

La documentation française de LibreOffice est disponible à
https://wiki.documentfoundation.org/Documentation/Publications/fr
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Qu’est-ce que Writer ?

Writer est le module de traitement de texte de LibreOffice. En plus des fonctions habituelles d’un 
traitement de texte (vérification orthographique, dictionnaire des synonymes, coupure des mots, 
autocorrection, recherche et remplacement, génération automatique de tables des matières et d’in-
dex, publipostage et autres), Writer offre des fonctions importantes :

• modèles et styles (chapitre 3) ;

• méthodes de mise en page incluant les cadres, les colonnes et les tableaux ;

• tables des matières et index automatiques ;

• intégration ou liaison d’images, feuilles de calcul et autres objets ;

• outils de dessin intégrés ;

• documents maîtres pour grouper une série de documents en un seul ;

• suivi des modifications lors des révisions ;

• intégration de bases de données, y compris une base de données bibliographique ;

• publipostage ;

• export au format PDF, comprenant les repères de texte (voir chapitre 10) ;

• signature numérique du document ;

• conception et remplissage de formulaire ;

• et bien plus encore.

Toutes ces fonctions sont abordées en détail dans le Guide de Writer.

L’interface de Writer

Barre 
d’état

Espace de travail

Barre 
de titre

Barre de 
menu

Barre d’outils 
standard

Barre d’outils 
formatage

Volet 
latéral

Barre 
d’état

Figure 1. L’espace de travail principal de Writer (Mise en page d’impression avec le volet latéral).
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L’espace de travail principal de Writer est affiché dans la Figure 1. Les menus ainsi que les barres 
d’outils sont décrits dans le chapitre 1, Présentation de LibreOffice de ce guide. D’autres fonctions 
de l’interface de Writer sont abordées dans ce chapitre.

Barre d’état

La barre d’état de Writer est située en bas de l’espace de travail. Elle fournit des informations rela-
tives au document et permet de modifier rapidement certaines caractéristiques du document (voir
Figure 2).

Nombre et 
numéro de page

Nombre de mots 
et de caractères

Langue

Mode d’insertion

Style de 
page

Mode de 
sélection

Document modifié

Signature 
électronique

Information 
sur l’objet

Agencement 
de l’affichage

Réglage 
du zoom

Pourcentage 
de zoom

Figure 2 : La barre d'état

Numéro de page

Affiche le numéro de page actuel, le numéro de séquence de la page active (si différent du 
numéro de page) et le nombre total de pages du document. Par exemple, si vous avez redé-
marré la numérotation des pages à 1 à la troisième page, le numéro de page est 1 et le nu-
méro de séquence est 3.

Si des repères de texte ont été définis dans le document, un clic droit sur ce champ affiche 
une liste des repères de texte ; cliquez sur l’un d’eux pour vous rendre à son emplacement.

Pour sauter à une page spécifique dans le document, double-cliquez sur ce champ. Le Navi-
gateur s’ouvre. Cliquez dans le champ Numéro de page dans le Navigateur et tapez le nu-
méro de séquence de la page voulue. Validez par Entrée, la page choisie s’affiche.

Compteur de mots et de caractères

Affiche le nombre de mots et de caractères contenus dans le document. Le compteur est mis
à jour tout au long de l’édition du document. Si vous sélectionnez une partie de texte dans le 
document, le compteur indiquera les informations relatives à cette sélection.

Pour afficher les statistiques plus détaillées (par exemple, le nombre de caractères excluant 
les espaces), cliquez sur le compteur de mots et de caractères dans la barre d’état ou sélec-
tionnez Outils > Statistiques dans la barre de menu.
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Vous pouvez aussi voir le nombre de mots et de caractères (ainsi que d’autres informations, 
y compris le nombre de pages, de tableaux et d’images) dans le document tout entier en sé-
lectionnant Fichier > Propriétés > Statistiques.

Style de page

Affiche le style de la page active. Pour modifier le style de page, faites un clic droit sur ce 
champ. Une liste des styles de page s’affiche ; choisissez un style différent en cliquant sur 
celui-ci.

Pour éditer le style de page, faites un double clic sur ce champ. La boîte de dialogue Style 
de page s’ouvre.

Langue

Affiche la langue du texte où le curseur se trouve ou du texte sélectionné. Cette fonction est 
utilisée pour la vérification orthographique, la césure des mots et les synonymes.

Cliquez pour ouvrir un menu où vous pouvez choisir une autre langue pour le texte sélection-
né ou pour le paragraphe dans lequel le curseur est situé. Vous pouvez également choisir 
Aucune (pas de vérification orthographique) pour exclure le texte de la vérification orthogra-
phique. Choisissez Plus… pour ouvrir la boîte de dialogue Caractère où vous pourrez modi-
fier la langue de la sélection. Vous pouvez aussi rétablir la langue par défaut depuis ce 
menu.

Mode de frappe

Cette zone est blanche lorsque le mode Insertion est actif. Cliquez sur cette zone pour bas-
culer vers le mode Écraser. Cliquez de nouveau pour revenir au mode Insertion. Vous pou-
vez aussi appuyer sur la touche Insér de votre clavier pour basculer entre les modes. En 
mode Insertion, le texte situé après le curseur se décale pour laisser l’espace au texte que 
vous tapez. En mode Écraser, le texte situé après le curseur est remplacé par le texte que 
vous tapez. Cette fonction est désactivée lorsque l’enregistrement des modifications (Édition
> Modifications > Enregistrer) est activé.

Mode de sélection

Faites un clic droit pour choisir un mode de sélection. L’icône ne change pas, mais lorsque 
vous placez le curseur de la souris au-dessus de cette icône, une infobulle vous indique quel
est le mode actif.

Lorsque vous cliquez sur l’icône, un menu contextuel affiche les modes de sélection dispo-
nibles.

Mode Effet

Sélection standard Cliquez dans le texte, là où vous souhaitez positionner le curseur 
de la souris. Cliquez sur un élément pour faire de lui l’élément ac-
tif. Toute autre sélection est alors désactivée.

Sélection étendue (F8) Cliquez dans le texte pour étendre ou réduire la sélection active.

Sélection avec ajout 
(Maj+F8)

Une nouvelle sélection est ajoutée à une sélection existante. Il 
s’agit d’une sélection multiple.

Sélection par bloc 
(Ctrl+Maj+F8)

Un bloc de texte peut être sélectionné.
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Sous le système d’exploitation Windows, vous pouvez maintenir enfoncée la touche Alt de 
votre clavier pendant que vous sélectionnez un bloc de texte avec la souris. De cette façon, 
vous n’aurez pas besoin de définir le mode de sélection par bloc.

Modifications non enregistrées

L’icône  est remplacée par l’icône  si les modifications du document n’ont pas été enre-
gistrées. Cliquez sur cette icône pour sauvegarder le document.

Signature numérique

Si le document a été signé numériquement, l’icône  apparaît sinon la zone est vide. Pour 
signer le document ou voir le certificat, cliquez sur l’icône.

Informations sur la section ou l’objet

Quand le curseur est dans une section, un titre, un élément de liste, ou quand un objet 
(comme une image, un tableau) est sélectionné, des informations à propos de l’élément s’af-
fichent dans ce champ. Double-cliquez dans cette zone pour ouvrir la boîte de dialogue cor-
respondante. Pour plus d’informations, référez-vous à l’Aide ou au Guide Writer.

Disposition des pages

Cliquez sur l’icône appropriée pour modifier la disposition des pages : page simple, côte à 
côte ou livre (voir Figure 3). Vous pouvez éditer le document dans n’importe quel affichage. 
Les paramètres du Zoom interagissent avec la disposition des pages sélectionnées pour dé-
terminer combien de pages seront visibles dans la fenêtre du document.

Figure 3 . Disposition des pages (page simple, côte à côte, livre).

Zoom

Pour modifier le grossissement de l’affichage, faites glisser le curseur du Zoom ou cliquez 
sur les signes + et –. Vous pouvez également faire un clic droit sur le pourcentage du Zoom 
pour sélectionner une valeur de grossissement ou  un clic gauche pour ouvrir la boîte de dia-
logue Zoom & disposition des pages. Les paramètres du Zoom interagissent avec la disposi-
tion sélectionnée pour les pages de façon à déterminer le nombre de pages visibles dans la 
fenêtre du document.
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Volet latéral

Le volet latéral de Writer (Affichage > Volet latéral) (voir Figure 4) est normalement ouvert par dé-
faut à droite de l’espace de travail. Il est muni d’un bouton permettant de le masquer ou de l’affi-
cher. Il s’agit d’un mélange de la barre d’outils et des boîtes de dialogue.

Configuration du 
volet latéral

Barre de titre

Bouton plus d’options

Onglets

Contenu de l’onglet

Titre de panneau

Contenu du panneau

Bouton 
Afficher/
Masquer

Figure 4 : L’onglet Propriétés du Volet latéral dans Writer

Le volet latéral de Writer est composé de cinq onglets : Propriétés, Page, Styles et formatage, Ga-
lerie et Navigateur. Si vous avez coché Activer les fonctions expérimentales dans Outils > Op-
tions > LibreOffice > Avancé, un sixième onglet (Gérer les modifications) apparaît et un septième
(Ébauche) peut être sélectionné dans Paramètres de la barre latérale > Personnalisation. 
Chaque onglet est représenté par une icône, situé à droite du volet latéral, qui vous permet de 
passer d’un onglet à l’autre.

Chaque onglet affiche sa barre de titre ainsi que les différentes options disponibles classées par 
panneaux. Les barres d’outils et certains panneaux du volet latéral partagent de nombreuses fonc-
tions. Par exemple, les boutons pour mettre du texte en gras ou en italique sont présents aussi 
bien dans la barre de formatage que dans le panneau Caractère de l’onglet Propriétés.

Certains panneaux disposent d’un petit bouton Plus d’options  qui ouvre une boîte de dialogue 
vous proposant un plus grand choix de fonctions. La boîte de dialogue qui s’affiche empêche toute 
modification du document jusqu’à ce qu’elle soit fermée.

Les onglets sont décrits ci-dessous.
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Onglet Propriétés 

Cet onglet affiche des outils relatifs au formatage direct dans le document. Par défaut, les 
outils sont divisés en trois panneaux pour l’édition de texte :

─ le panneau Styles permet de modifier le style du paragraphe en cours ou de créer un 
nouveau style à partir du paragraphe sélectionné ;

─ le panneau Caractère permet de modifier la police, la taille, la couleur, la grandeur, le 
style ou l’espacement du texte ;

─ le panneau Paragraphe permet de modifier l’alignement, les puces et numérotations, la 
couleur d’arrière-plan, le retrait ou l’espacement du paragraphe.

Si un objet image est sélectionné, d’autres panneaux s’affichent dans l’onglet Propriétés :

─ le panneau Zone permet de modifier le mode de remplissage de l’arrière-plan de l’objet et
de déterminer le type de transparence ;

─ le panneau Image permet de modifier la luminosité, le contraste, le mode de couleur ou la
transparence de l’objet ;

─ le panneau Adaptation du texte permet de déterminer comment l’objet doit se comporter 
vis-à-vis du texte contenu dans le document ;

─ le panneau Position et taille permet de modifier la hauteur et la largeur de l’objet. Les 
fonctions Rotation et Retourner sont disponibles.

Si un objet de dessin est sélectionné, les panneaux suivants sont disponibles :

─ le panneau Zone permet de modifier le remplissage et la transparence de l’objet ;

─ le panneau Ligne permet d’éditer le style, la largeur, la couleur et les extrémités des 
lignes ainsi que leur transparence ;

─ le panneau Position et taille permet de modifier la position et la rotation de l’objet et de 
lui appliquer une symétrie horizontale ou verticale.

Si un cadre est sélectionné, la catégorie Adaptation du texte s’affiche mais certaines fonc-
tions peuvent être grisées en raison de leur incompatibilité avec le type de cadre.

Si un clip vidéo ou audio est inséré (par Insertion > Média > Son ou vidéo…), les panneaux
suivants s’ouvrent quand ce clip est sélectionné :

─ le panneau Lecture du média offre les contrôles pour exécuter, mettre en pause, arrêter, 
répéter le clip, y faire une recherche et régler le volume sonore ;

─ le panneau Position et taille permette de régler la position et la taille du clip dans le do-
cument.

Onglet Page 

Cet onglet offre des outils qui permettent de mettre directement en forme la page. Il possède 
quatre panneaux :

─ le panneau Format permet de modifier la taille, la largeur, la hauteur, l’orientation et les 
marges de la page ;
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─ le panneau Styles permet de modifier le style de numérotation de la page, l’arrière-plan, 
la disposition et le nombre de colonnes ;

─ le panneau En-tête active ou désactive l’en-tête et modifie ses marges, son espacement 
et son contenu ;

─ le panneau Pied de page active ou désactive le pied de page et modifie ses marges, son 
espacement et son contenu.

! Attention

Soyez conscient que si vous modifiez les options de l’onglet Page, vous modifierez le style 
de page utilisé. Cela n’affectera pas seulement la page en cours, mais toutes les pages utili-
sant le même style de page.

Onglet Styles et formatage 

Cet onglet permet de gérer les styles utilisés dans le document, d’appliquer d’autres styles 
existants, d’en créer des nouveaux ou de les modifier. Vous pouvez avoir un aperçu des mo-
difications en cochant la case Afficher les aperçus en bas du volet latéral. Vous pouvez y ac-
céder également via le menu Affichage > Gérer les styles ou en appuyant sur la touche 
F11.

Onglet Galerie 

Il permet d’ajouter des images disponibles dans la Galerie. La galerie se divise en deux sec-
tions. La première répertorie tous les thèmes par leur nom (arrière-plans, flèches, formes de 
base, etc.) et la seconde affiche les images du thème sélectionné. Pour créer un nouveau 
thème, cliquez sur le bouton Nouveau thème… Pour insérer une image dans un dossier ou 
ajouter une image à un nouveau thème, recherchez les images sur votre ordinateur puis 
faites un glisser-déposer de cette image jusqu’à la galerie. Vous pouvez y accéder égale-
ment via le menu Affichage > Galerie ou en cliquant sur le bouton Galerie de Média et 
Open Clip Art de la barre d’outils standard.

Onglet Navigateur 

Cet onglet permet de naviguer dans le document et de réorganiser son contenu en sélection-
nant différentes catégories, telles que les titres, les tableaux, les cadres ou les objets. Il est 
semblable à la fenêtre flottante qui s’ouvre par le menu Affichage > Navigateur, en cliquant 
sur le bouton Navigateur de la barre d’outils standard ou en appuyant sur la touche F5. Il est
à noter que le navigateur du volet latéral ne contient pas le bouton Afficher/masquer la 
zone de liste qui réduit la taille de la fenêtre.

Onglet Gérer les modifications 

Il affiche toutes les modifications effectuées dans le document depuis l’activation du mode 
Enregistrer les modifications. Cet onglet est une alternative à la boîte de dialogue Gérer 
les modifications qui peut être ouverte par Édition > Suivi des modifications > Gérer… 
dans la barre de menu. Il n’est disponible que si l’option Activer les fonctions expérimentales 
a été cochée dans la page LibreOffice – Avancé de la boîte de dialogue Options (Outils > 
Options).
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Onglet Ébauche 

Il offre un accès rapide aux thèmes (polices et couleurs) et styles prédéfinis. Cet onglet n’est 
disponible que si l’option Activer les fonctions expérimentales a été cochée dans la page 
LibreOffice – Avancé de la boîte de dialogue Options (Outils > Options) et s’il est sélection-
né dans Paramètres de la barre latérale > Personnalisation.

Modifier l’affichage du document

Writer propose trois façons d’afficher un document : Normal (auparavant appelé Mise en page 
d’impression), Web et Plein écran. Pour changer l’affichage, allez dans le menu Affichage et cli-
quez sur le mode voulu. (En mode plein écran, appuyez sur la touche Échap pour revenir au mode
normal ou web.)

Affichage normal

Le mode Normal est l’affichage par défaut de Writer. Dans ce mode, vous pouvez utiliser le 
curseur du Zoom et les icônes de disposition des pages situés dans la barre d’état afin de 
changer le grossissement du document. Vous pouvez également cliquer sur Affichage > 
Zoom > Zoom… dans la barre des menus pour afficher la boîte de dialogue Zoom & dispo-
sition des pages (voir Figure 5) qui vous permet de paramétrer les mêmes options que la 
barre d’état.

Figure 5. Choix du Zoom et des options de disposition des pages.

Dans le mode Normal, vous pouvez afficher ou masquer les en-têtes et pieds de pages ainsi
que l’espace entre les pages. Pour cela, sélectionnez Affichage > Masquer les espaces 
vides dans la barre de menu. Une coche apparaîtra en face de l’option. Une fois celle-ci sé-
lectionnée, les espaces vides seront aussi cachés en mode Plein écran. Notez que cette op-
tion ne fonctionne que si l’affichage d’une seule page est activé dans la barre d’état.

Affichage web

En mode Web, le curseur de zoom reste disponible, tandis que les boutons de disposition 
des pages sont désactivés. En outre, la plupart des choix proposés dans la boîte de dialogue
Zoom & disposition des pages ne sont plus utilisables. Cette vue n’offre aucun affichage 
des limites de la page.

Affichage plein écran

En mode Plein écran, le document est affiché en utilisant les réglages de zoom et de disposi-
tion des pages précédemment sélectionnés pour les autres vues. Pour quitter le mode Plein 
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écran et retourner au mode Normal ou Web, appuyez sur la touche Échap ou cliquez sur le 
bouton Plein écran en haut à gauche. Vous pouvez aussi utiliser le raccourci clavier 
Ctrl+Maj+J pour entrer ou sortir du mode Plein écran.

Se déplacer rapidement dans un document

Grâce au navigateur

En plus des options de navigation de la barre d’état décrites ci-dessus, vous pouvez utiliser la fe-
nêtre du Navigateur (disponible depuis la barre d’outils standard) ou l’onglet Navigateur (disponible
depuis le volet latéral) comme décrit dans le chapitre 1, Introduction à LibreOffice, de ce guide.

La barre de Navigation (voir Figure 6), affiche les icônes de tous les types d’objets disponibles 
dans le navigateur.

Figure 6 : Barre d’outils Navigation

Cliquez sur une icône pour sélectionner le type d’objet. Après cette manipulation, les icônes Pré-

cédent ( )et Suivant ( ) (dans le navigateur lui-même, dans la barre de Navigation et dans la 
barre d’outils Rechercher) permettront d’atteindre l’objet suivant ou précédent du type sélectionné. 
Cela est particulièrement pratique pour retrouver des éléments comme les entrées d’index qui 
peuvent être difficiles à voir dans le texte. Les noms des icônes (affichés dans les infobulles) sont 
modifiés pour correspondre à la catégorie sélectionnée ; par exemple Image suivante, Repère de
texte suivant ou Rechercher le suivant.

Pour plus d’informations sur le navigateur dans Writer, référez-vous au Guide Writer.

Grâce à la boîte de dialogue Aller à la page…

Nouveau depuis la version 5.3

Writer dispose d’une boîte de dialogue qui permet d’atteindre directement une page.

Pour atteindre une page du document, vous pouvez sélectionner Édition > Aller à la page… dans
la barre de menu ou le raccourci Ctrl+Maj+F5 au clavier pour afficher la boîte de dialogue Aller à
la page (Figure 7). À son ouverture, elle affiche le numéro de la page courante ainsi que le nombre
de pages dans le document. Tapez, dans la boîte de saisie, le numéro de la page que vous sou-
haitez atteindre puis cliquez sur le bouton OK.

Figure 7 : La boîte de dialogue Aller à la page.
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Travailler avec les documents

Le chapitre 1, Introduction à LibreOffice, de ce guide, aborde la création de nouveaux documents, 
l’ouverture de documents existants, l’enregistrement de documents et la protection par mot de 
passe de documents. Le chapitre 3, Utiliser les styles et les modèles, explique comment créer un 
document depuis un modèle.

Par défaut, LibreOffice charge et enregistre les fichiers dans le format OpenDocument (ODF : 
OpenDocument Format), format de fichier standardisé (ISO-IEC 26300) utilisé par de nombreuses 
applications. Les documents Writer ont l’extension .odt (ODT : OpenDocument Text).

Conseil

Chaque fois que vous avez le choix du format de fichier, choisissez le format ODF par dé-
faut quand vous travaillez avec LibreOffice.

Enregistrer dans le format Microsoft Word

Si vous partagez vos documents avec des utilisateurs de Microsoft qui n’aiment pas recevoir des 
fichiers .odt ou qui n’arrivent pas à les ouvrir, vous pouvez ouvrir, éditer et enregistrer vos docu-
ments dans les formats de Microsoft Word. Vous pouvez également créer et éditer des fichiers .odt
et les enregistrer par la suite en .doc ou en .docx. Pour cela, procédez de la manière suivante :

 1) Important : Commencez par enregistrer votre document dans le format de fichier utilisé par 
LibreOffice (.odt). Si vous ne le faites pas, tous les changements que vous apporterez au do-
cument après le dernier enregistrement au format OpenDocument apparaîtront uniquement 
dans la version du document pour Microsoft Word. En supplément, cela vous permet d’enre-
gistrer de nouveau ou de modifier le document si son destinataire rencontre des problèmes 
avec le format de Microsoft.

 2) Cliquez ensuite sur le menu Fichier > Enregistrer sous (voir Figure 8).

 3) Dans la liste déroulante Type de la boîte de dialogue Enregistrer sous, sélectionnez le type 
de format Word dont vous avez besoin. Vous pouvez aussi en profiter pour changer le nom 
du fichier.

 4) Cliquez ensuite sur Enregistrer.

Cette opération crée un document différent avec une autre extension (par exemple, .docx). À partir
de moment, toutes les modifications que vous effectuerez dans le document apparaîtront unique-
ment dans le nouveau document. Si vous souhaitez continuer à travailler dans la version .odt, vous
devrez ouvrir à nouveau le document enregistré au format .odt.

Il est aussi possible d’utiliser le menu Fichier > Enregistrer une copie… pour enregistrer une co-
pie de votre fichier dans son état actuel en changeant son format comme expliqué ci-dessus. Vous
pouvez ensuite continuer à travailler sur votre document au format .odt. Si vous lui apportez des 
modifications, il faudra renouveler cette opération pour que les versions dans les deux formats res-
tent synchronisées.
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Figure 8 : Enregistrer un fichier dans le format Microsoft Word

Conseil

Pour que Writer enregistre par défaut vos documents dans le format Microsoft Word, sélec-
tionnez Outils > Options dans la barre de menu ; dans la boîte de dialogue Options, ouvrez
la page Chargement/enregistrement – Général. Dans la section Enregistrer systématique-
ment sous, choisissez votre format de fichier préféré (voir Figure 9).

Figure 9 : Outils > Options > Chargement/enregistrement > Général.
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Utiliser les outils linguistiques intégrés

Writer fournit quelques outils qui pourraient faciliter votre travail si vous utilisez plusieurs langues 
dans un même document ou si vous rédigez des documents dans de nombreuses langues.

Le principal avantage de modifier la langue pour une sélection réside dans le fait que vous pouvez 
ensuite utiliser les dictionnaires adéquats afin de vérifier l’orthographe et la grammaire, appliquer 
les tables de remplacement de l’AutoCorrection, les synonymes ainsi que les règles de césure 
adaptés à la langue définie.

Options pour l’application de langues

Conseil

La langue utilisée à l’emplacement du curseur est indiquée dans la barre d’état, à côté du 
style de page utilisé (voir Figure 2).

Utiliser les styles

Les langues peuvent être définies dans l’onglet Police des boîtes de dialogue Style de paragraphe 
et Style de caractère.

Reportez-vous au Guide Writer pour plus d’informations sur la manière de gérer les paramètres de
langue dans un style.

Remarque

Faites attention si vous modifiez la langue d’un style de caractère ou de paragraphe, car elle
sera modifiée pour tous les caractères et paragraphes qui utilisent ce style. Il peut être utile 
d’inclure le nom de la langue dans celui du style.

N’oubliez pas non plus que la langue définie par mise en forme directe l’emportera sur celle 
définie dans un style.

Utiliser la mise en forme directe

La langue d’un document entier peut être définie dans la page Paramètres linguistiques – Langues
de la boîte de dialogue Options (Outils > Options). Dans la section Langues par défaut des do-
cuments, vous pouvez choisir la langue pour tout texte pour laquelle une autre n’est pas explicite-
ment précisée.

Vous pouvez définir la langue du document tout entier, de paragraphes ou de caractères indivi-
duels grâce au menu Outils > Langue.

Vous pouvez aussi modifier la langue pour des paragraphes ou des caractères individuels en sé-
lectionnant le texte et en modifiant la langue dans la barre d’état.

Remarque

Bien que ces méthodes constituent une forme de formatage direct, elles ne peuvent pas être
éliminées en utilisant Effacer le formatage direct dans le menu Format ou le raccourci 
Ctrl+M au clavier.
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Empêcher la vérification orthographique d’un texte

Vous pouvez définir la valeur Aucune (Pas de vérification orthographique) comme langue pour un 
paragraphe ou un groupe de caractères en utilisant l’une des méthodes décrites ci-dessus. Cette 
possibilité est, par exemple, particulièrement utile pour des adresses web ou des fragments de 
code en langage de programmation.

Obtenir des ressources pour des langues supplémentaires

La vérification orthographique ne fonctionne que pour les langues précédées de l’icône  dans la 
liste de la boîte de dialogue Orthographe (décrite à la page 20). Si vous ne voyez pas cette icône à
côté de la langue qui vous intéresse, vous pouvez installer le dictionnaire supplémentaire grâce au
menu Outils > Langue > Dictionnaires supplémentaires en ligne…

Travailler avec le texte

Le travail sur le texte dans Writer (sélectionner, copier, coller, déplacer) s’effectue de la même fa-
çon que dans tout autre logiciel de traitement de texte. LibreOffice propose plusieurs moyens pra-
tiques pour sélectionner des éléments qui ne sont pas contigus ou un bloc de texte vertical ainsi 
que pour coller du texte non formaté.

Sélectionner des éléments disjoints

Pour sélectionner des éléments disjoints (voir Figure 10) en utilisant le clavier et la souris :

Figure 10. Sélectionner des éléments qui ne sont pas proches les uns des autres.

 1) Sélectionnez le premier morceau de texte.

 2) Maintenez la touche Ctrl enfoncée et utilisez la souris pour sélectionner le morceau de 
texte suivant.

 3) Répétez l’opération autant de fois que nécessaire.

Vous pouvez travailler avec le texte sélectionné (le copier, le supprimer, en changer le style, etc.).
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Note pour les utilisateurs Mac

Remplacez la touche Ctrl par la touche Commande.

 Pour sélectionner des éléments disjoints en utilisant uniquement le clavier :

 1) Sélectionnez le premier morceau de texte. Pour sélectionner du texte à l’aide du clavier, 
maintenez la touche Maj enfoncée et utilisez les flèches de direction.

 2) Appuyez sur les touches Maj+F8 de votre clavier afin d’activer le mode Sélection avec ajout 
de Writer.

 3) Utilisez les touches de direction de votre clavier pour vous déplacer au début du morceau de
texte suivant à sélectionner. Maintenez la touche Maj enfoncée et sélectionnez le morceau 
de texte suivant.

 4) Répétez l’opération autant de fois que nécessaire.

Vous pouvez travailler avec le texte sélectionné (le copier, le supprimer, en changer le style, etc.).

Pour quitter le mode Sélection avec ajout, appuyez sur les touches Maj+F8 ou la touche Échap 
de votre clavier.

Pour plus d’informations sur la sélection de texte avec le clavier, voir le sujet « Navigation et sélec-
tion à l'aide du clavier » dans l’aide en ligne (F1).

Sélectionner un bloc de texte vertical

Grâce au mode Sélection par bloc, vous pouvez sélectionner un bloc vertical ou une “colonne” de 
texte qui est séparée par des espaces ou des tabulations (comme on peut le rencontrer dans le 
texte collé depuis des courriels, des listings ou d’autres sources). Pour activer le mode Sélection 
par bloc, cliquez sur le menu Édition > Mode sélection > Zone de bloc, ou cliquez dans la barre 
d’état. Vous pouvez également appuyer sur les touches Ctrl+Maj+F8 de votre clavier.

Figure 11 : Activer le mode de sélection par bloc grâce à la barre d’état.

Vous pouvez maintenant mettre en surbrillance la sélection en utilisant la souris ou le clavier (voir
Figure 12).

Figure 12. Sélectionner un bloc de texte vertical.
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Couper, copier et coller du texte

Couper et coller du texte dans Writer de la même façon que dans d’autres programmes. Vous pou-
vez copier/déplacer du texte à l’intérieur d’un même document, ou d’un document vers un autre 
document, par glisser-déposer, en utilisant des entrées du menu, des icônes ou des raccourcis cla-
vier. Vous pouvez également copier du texte dans d’autres sources, telles que des pages Web, et 
le coller dans un document Writer.

Pour déplacer (couper et coller) le texte sélectionné en utilisant la souris, faites glisser et déposez 
le texte sélectionné à son nouvel emplacement. Pour copier le texte sélectionné en utilisant la sou-
ris, maintenez enfoncée la touche Ctrl de votre clavier pendant le déplacement. Le formatage du 
texte copié est préservé.

Après avoir sélectionné du texte, vous pouvez également le couper, le copier et coller du texte de 
l’une des manières suivantes :

pour le couper, utilisez le menu Édition > Couper, le raccourci clavier Ctrl+X ou l’icône
Couper de la barre d’outils Standard ;

pour le copier, utilisez le menu Édition > Copier, le raccourci clavier  Ctrl+C ou l’icône
Copier de la barre d’outils Standard ;

pour le coller, utilisez le menu Édition > Coller, le raccourci clavier Ctrl+V ou l’icône Col-
ler de la barre d’outils Standard.

Le résultat d’une opération de collage dépend de la source du texte à coller. Si vous utilisez sim-
plement une des méthodes précédentes pour le coller, le formatage du texte est préservé quel qu’il
soit  (gras ou italique par exemple). Le texte collé depuis un site Web ou d’autres sources peut 
également être placé dans des cadres ou dans des tableaux. Si le résultat ne vous paraît pas sa-
tisfaisant, cliquez sur l’icône Annuler ou appuyez sur Ctrl+Z.

Pour que le texte collé hérite du style de paragraphe au point d’insertion, utilisez une des mé-
thodes suivantes :

• sélectionnez Édition > Collage spécial dans la barre de menu ;

• cliquez sur le triangle situé à droite de l’icône Coller dans la barre d’outils Standard ;

• cliquez sur l’icône Coller sans relâcher le bouton gauche de la souris ;

• appuyez sur les touches Ctrl+Maj+V de votre clavier.

Ensuite, choisissez Texte non formaté dans la boîte de dialogue ou le menu déroulant. Un texte 
nom formaté peut aussi être collé par le raccourci Maj+Ctrl+Alt+V.

L’étendue des choix dans le menu Collage spécial varie en fonction de l’origine et du formatage 
du texte (ou des autres objets) à coller. Voir la Figure 13 pour un exemple quand le presse-papiers 
contient du texte.
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Figure 13. Menu et boîte de dialogue Collage spécial.

Rechercher et remplacer du texte et du formatage

Writer a deux moyens de trouver du texte dans un document : la barre d’outils Rechercher pour 
une recherche rapide et la boîte de dialogue Rechercher & Remplacer. Dans la boîte de dialogue 
Rechercher & Remplacer, vous pouvez :

• trouver et remplacer des mots ainsi que des phrases ;

• utiliser les caractères génériques et les expressions régulières pour affiner la recherche ;

• rechercher et remplacer des formatages spécifiques ;

• rechercher et remplacer des styles de paragraphe.

Utiliser la barre d’outils Rechercher

Si la barre d’outils Rechercher n’est pas visible, vous pouvez l’afficher en cliquant sur le menu Affi-
chage > Barres d’outils > Rechercher ou en appuyant sur les touches Ctrl+F de votre clavier. 
Par défaut, la barre d’outils Rechercher est ancrée au bas de la fenêtre de LibreOffice, juste au-
dessus de la barre d’état (voir Figure 14). Vous pouvez également la rendre flottante ou l’ancrer à 
un autre endroit. Pour plus d’information sur les barres d’outils flottantes et ancrées, référez-vous 
au chapitre 1, Introduction à LibreOffice, de ce guide.

Figure 14. Position par défaut de la barre d’outils Rechercher.

Pour utiliser la barre d’outils Rechercher, cliquez dans le champ et saisissez le texte à rechercher. 
Appuyez ensuite sur la touche Entrée de votre clavier pour trouver la prochaine occurrence du 

16 | Débuter avec Writer



texte saisi. Cliquez sur les boutons Rechercher le suivant ( ) ou Rechercher le précédent (
) en fonction de vos besoins.

Cliquez sur le bouton Tout rechercher pour sélectionner toutes les occurrences de texte conte-
nues dans le document. Cochez l’option Respecter la casse pour rechercher uniquement les oc-
currences qui correspondent strictement au terme recherché. Cliquez sur le bouton Rechercher & 

remplacer ( ) à droite de l’option Respecter la casse pour ouvrir la boîte de dialogue Recher-
cher & remplacer.

Nouveau dans la version 6.0

La barre d’outils Rechercher propose une liste des types de contenus accessibles sans ou-
vrir le navigateur.

Pour rechercher uniquement un type particulier de contenu, déroulez la liste Naviguer par et faites
votre choix. Par exemple, pour faire une recherche dans les titres ou pour les parcourir à partir de 
la position courante, sélectionnez ce type de contenu. Vous pouvez vous déplacer dans le docu-
ment en passant d’un élément à l’autre en cliquant sur les boutons [Élément] précédent  ou 
[Élément] suivant .

Figure 15 : la liste de recherches sélectives.

La barre d’outils Rechercher peut être fermée en cliquant sur la croix rouge à gauche ou en ap-
puyant sur la touche Échap de votre clavier lorsque le curseur se trouve dans la zone de re-
cherche. Le raccourci Ctrl+F affiche et ancre cette barre d’outils.

Utiliser la boîte de dialogue Rechercher & remplacer

Pour afficher la boîte de dialogue Rechercher & remplacer, cliquez sur le menu Édition > Recher-
cher & remplacer ou appuyez sur les touches Ctrl+H de votre clavier. Si la barre d’outils Re-
chercher est ouverte, cliquez sur le bouton Rechercher & remplacer . Pour obtenir plus d’op-
tions, cliquez sur le bouton Options supplémentaires de la boîte de dialogue. Cliquez une nou-
velle fois sur le bouton pour les masquer (Figure 16).

Pour utiliser la boîte de dialogue Rechercher & remplacer :

 1) Saisissez le texte que vous souhaitez trouver dans le champ Rechercher.

 2) Pour remplacer le texte recherché par un texte différent, saisissez le nouveau texte dans le 
champ Remplacer.

 3) Vous pouvez sélectionner des options telles que Respecter la casse, Mots entiers unique-
ment ou Rechercher des similarités.
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Parmi les options supplémentaires, vous pouvez choisir de n’effectuer la recherche que dans
la sélection courante, d’effectuer la recherche vers le début du document plutôt que vers la 
fin, rechercher des mots similaires ou parmi les commentaires.

Conseil

Les expressions régulières offrent un moyen puissant pour rechercher et remplacer du texte.
Elles permettent, par exemple, de trouver toutes les instances où un nombre est suivi de 
lettres précises. Elles peuvent, toutefois, être difficiles à comprendre. Reportez-vous à l’aide 
pour vous y aider.

 4) Lorsque vous avez défini votre recherche, cliquez sur le bouton Rechercher. Pour remplacer
le texte, cliquez sur le bouton Remplacer.

Si vous cliquez sur Tout rechercher, LibreOffice sélectionne toutes les instances du texte 
recherché dans le document. De la même manière, si vous cliquez sur Tout remplacer, 
toutes ces instances seront remplacées par le texte que vous avez choisi, sans vous deman-
dez de valider chaque remplacement.

Figure 16 : la boîte de dialogue Rechercher & remplacer avec les options supplémentaires

Pour plus d’informations sur la boîte de dialogue Rechercher & remplacer, référez-vous au Guide 
Writer.

! Attention

Utilisez le bouton Tout remplacer avec précaution ; vous pourriez provoquer des erreurs 
embarrassantes. Une erreur avec le bouton Tout remplacer peut nécessiter une recherche 
manuelle, mot par mot, pour la corriger si elle n’est pas découverte à temps pour l’annuler.

Insérer des caractères spéciaux

Nouveau dans la version 6.0

La boîte de dialogue de sélection des caractères spéciaux a été améliorée.
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Un caractère spécial est un caractère qui n’est pas présent sur un clavier standard de votre 
langue. Par exemple, © ¾ æ ç Ł ñ ö ø ¢ sont des caractères spéciaux. Pour insérer un caractère 
spécial :

 1) Placez le curseur de la souris à l’endroit où vous souhaitez insérer le caractère spécial dans 
votre document.

 2) Cliquez sur le menu Insertion > Caractères spéciaux ou sur l’icône Caractères spéciaux
 dans la barre d’outils Standard pour ouvrir la boîte de dialogue Caractères spéciaux.

 3) Pour insérer plusieurs caractères, faites un double clic sur les caractères (de n’importe 
quelle police ou sous-ensemble) que vous souhaitez insérer pour qu’ils apparaissent dans le 
document. Les caractères sélectionnés apparaissent aussi dans la liste des Caractères ré-
cents en bas à gauche de la boîte de dialogue. Un clic droit sur l’un des caractères récents 
permet de le supprimer ou d’effacer totalement l’historique.

Pour insérer un caractère et refermer la boîte de dialogue, cliquez sur celui-ci puis sur le 
bouton Insérer.

Figure 17. La boîte de dialogue Caractères spéciaux.

Conseil

Pour visualiser les détails d’un caractère, faites un simple clic sur celui-ci ; il apparaît dans la
zone d’aperçu à droite de la boîte de dialogue avec ses codes numériques.

Différentes polices incluent différents caractères spéciaux. Si vous ne trouvez pas un carac-
tère spécial particulier, essayez de changer la Police.
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La commande Rechercher & Remplacer permet l’accès aux caractères spéciaux par un clic 
droit dans les zones Rechercher et Remplacer par.

Insérer des tirets et des espaces insécables

Insérer des espaces insécables

Afin d’éviter que deux mots ne soient séparés à la fin d’une ligne, appuyez sur les touches 
Ctrl+Maj+Espace de votre clavier lorsque vous saisissez l’espace entre les deux mots.

Insérer des tirets insécables

Vous pouvez utiliser un tiret insécable si vous ne souhaitez pas que le trait d’union apparaisse à la 
fin d’une ligne (par exemple : dans un numéro tel que 123-4567). Pour insérer un tiret insécable, 
appuyez sur les touches Ctrl+Maj+signe moins (le moins du pavé numérique) de votre cla-
vier.

Insérer des tirets cadratins et demi-cadratins

Pour saisir des tirets cadratins (tirets longs) et demi-cadratins (tirets), vous pouvez utiliser l’option 
Remplacer les tirets (active par défaut) dans l’onglet Options de la la boîte de dialogue AutoCor-
rection (menu Outils > AutoCorrection > Options d’AutoCorrection). Cette option remplace 
deux tirets sous certaines conditions par le tiret correspondant.

– Pour insérer un tiret demi-cadratin (tiret) qui aura la taille de la lettre “n” dans la police que 
vous utilisez : tapez au moins un caractère, un espace, un ou deux tirets, un autre espace et 
au moins un caractère pour terminer. Le tiret (ou les deux) que vous avez tapé est remplacé 
par un tiret demi-cadratin.

— Pour insérer un tiret cadratin (tiret long) qui aura la taille de la lettre “m” dans la police que 
vous utilisez : tapez au moins un caractère, deux tirets et au moins un caractère pour terminer.
Les deux tirets sont remplacés par un tiret cadratin. Si les caractères sont des chiffres, comme
dans une date ou un intervalle de temps, les deux tirets seront remplacés par un tiret demi-ca-
dratin.

Consultez l’aide du logiciel pour plus de détails. Pour obtenir d’autres renseignements, référez-
vous également au chapitre 3, Travailler avec du texte, du Guide de Writer.

Vérification orthographique et grammaticale

Par défaut, quatre dictionnaires sont installés pour chaque langue : un dictionnaire orthographique,
un dictionnaire grammatical, un dictionnaire de coupure de mots et un dictionnaire des synonymes 
(en supposant qu’ils existent pour la langue en question). Le vérificateur orthographique contrôle 
que chaque mot du document se trouve dans le dictionnaire installé. Il offre aussi une vérification 
grammaticale qui peut être utilisée séparément ou en association avec la vérification orthogra-
phique.

Correction orthographique automatique

Quand l’icône correspondante ( ) est cochée, LibreOffice vérifie chaque mot pendant la frappe et
affiche un soulignement rouge ondulé en dessous des mots non reconnus. Faites un clic droit sur 
un de ces mots pour ouvrir un menu contextuel. Vous pourrez alors cliquer sur un des mots propo-
sés pour qu’il remplace le mot souligné. Si la liste ne contient pas le mot que vous désirez, cliquez 
sur Orthographe… pour ouvrir une boîte de dialogue. Lorsque le mot est corrigé, cette ligne dis-
paraît.
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Vérifier l’orthographe et la grammaire

Pour effectuer une vérification du document ou d’une sélection) combinant l’orthographe et la 
grammaire, cliquez sur l’icône Orthographe et grammaire ( ) de la barre d’outils Standard ou 
sélectionnez le menu Outils > Orthographe et grammaire. Cette fonction vérifie le document ou 
la sélection et ouvre la boîte de dialogue Orthographe et grammaire si des mots non reconnus sont
détectés. Pour détecter aussi d’éventuels problèmes grammaticaux, cochez l’option Vérifier la 
grammaire en bas de la boîte de dialogue.

Voici quelques fonctions relatives à la correction orthographique.

Changer la langue du dictionnaire

Vous pouvez changer la langue du dictionnaire (par exemple en espagnol, anglais ou alle-
mand) dans la boîte de dialogue Orthographe et grammaire, en la sélectionnant dans la liste 
déroulante Langue du texte.

Ajouter un mot au dictionnaire

Vous pouvez ajouter un mot au dictionnaire en choisissant l’entrée Ajouter au dictionnaire 
du menu contextuel qui apparaît lorsque vous faites un clic-droit sur un mot inconnu. Le mot 
sera ajouté au dictionnaire Standard, sauf si vous en avez créé un autre dans la même 
langue. Dans ce cas, vous pourrez choisir celui auquel le mot sera ajouté.

Choisir les options de la vérification orthographique

Dans la boîte de dialogue Orthographe et grammaire, cliquez sur le bouton Options pour ou-
vrir une boîte de dialogue similaire à celle disponible via le menu Outils > Options > Para-
mètres linguistiques > Linguistiques qui est décrite au chapitre 2 de ce guide. Dans cette 
boîte de dialogue, vous pouvez déterminer ce que vous souhaitez vérifier (mots en majus-
cules ou comportant des chiffres) et paramétrer les dictionnaires (les personnaliser, en ajou-
ter ou en supprimer).

Gérer les dictionnaires personnalisés

Dans cette même boîte de dialogue, vous pouvez créer, éditer ou supprimer des diction-
naires et modifier les mots qu’ils contiennent.

Préciser la langue d’un paragraphe particulier

Il existe plusieurs méthodes qui vous permettent de déterminer quels paragraphes doivent 
être vérifiés et dans quelle langue (différente du reste du document). Vous pouvez, par 
exemple, cliquer sur la langue dans la barre d’état ou créer un style de paragraphe propre à 
une langue donnée. Pour plus d’informations, référez-vous à « Utiliser les outils linguis-
tiques intégrés » page 12 ou au chapitre 7, Travailler avec les styles, du Guide Writer.

Vérification orthographique avec « Grammaire par »

Nouveau dans LibreOffice 6.0

Il est maintenant plus facile de compléter le dictionnaire avec un mot comportant différentes 
flexions et dérivés.

Cette nouvelle fonction permet au dictionnaire de reconnaître différentes formes construites 
à partir du même mot sans avoir à les saisir individuellement., ce qui est particulièrement 
utile pour les mots nouveaux ou spécialisés dont toutes les variations ne sont probablement 
pas dans le dictionnaire. 
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Pour utiliser cette fonctionnalité, commencez par créer un nouveau dictionnaire dans la fe-
nêtre Options de la boîte de dialogue Orthographe. Sélectionnez-le puis cliquez sur Éditer. 
Saisissez ensuite le mot de base dans le champ Mot et,  dans le champ Grammaire par, un 
mot de référence qui présente les mêmes variations que le mot de base.

Pour plus d’informations sur la vérification orthographique et grammaticale, référez-vous au cha-
pitre 3, Travailler avec du texte, du Guide Writer.

Utiliser le dictionnaire des synonymes

Pour accéder à une courte liste de synonymes, faites un clic droit sur un mot et sélectionnez Sy-
nonymes dans le menu contextuel. Un sous-menu contenant des mots et phrases alternatifs s’af-
fiche. Cliquez sur un mot ou une phrase dans celui-ci pour qu’il remplace le mot ou la phrase sé-
lectionné dans le document.

Le dictionnaire des synonymes offre une liste plus étendue de mots ou phrases de remplacement. 
Pour l’utiliser, cliquez sur Dictionnaire des synonymes en bas de la liste des alternatives, sélec-
tionnez Outils > Dictionnaire des synonymes dans la barre de menu ou appuyez sur Ctrl+F7 
sur votre clavier. Si le dictionnaire des synonymes pour la langue en cours d’utilisation n’est pas 
installé, cette fonction est désactivée.

Remarque

Le dictionnaire des synonymes est un outil d’écriture proposé par la communauté des utili-
sateurs. Si celui-ci n’est pas disponible dans votre langue, n’hésitez pas à envisager de 
vous joindre au projet LibreOffice pour aider la communauté de votre langue à en créer un.

Utiliser l’AutoCorrection

Les options d’Autocorrection de Writer constituent une longue liste de fautes d’orthographe ou de 
frappe courantes et d’erreurs typiques qui peuvent être corrigées automatiquement. Par exemple, 
“dse” sera remplacé par “des”. Elle offre aussi des codes pour insérer des caractères spéciaux, 
des émoticônes et d’autres symboles.

Les options d’Autocorrection sont activées par défaut. Pour les désactiver, décochez l’option via le 
menu Outils > AutoCorrection > Pendant la frappe.

Pour ouvrir la boîte de dialogue AutoCorrection, cliquez sur le menu Outils > AutoCorrection > 
Options d’AutoCorrection. Vous pouvez y définir quels sont les mots à corriger, le texte de rem-
placement et le format à utiliser. À noter que de nombreuses entrées sont déjà disponibles.

Afin que Writer arrête de remplacer un mot mal orthographié, cliquez sur l’onglet Remplacer de la 
boîte de dialogue AutoCorrection. Sélectionnez le mot mal orthographié et son remplaçant, puis 
cliquez sur le bouton Supprimer.

Pour ajouter un nouveau mot à la liste, saisissez sa version mal orthographiée dans le champ 
Remplacer ainsi que son remplaçant dans le champ Par. Cliquez ensuite sur le bouton Nouveau.

N’hésitez pas à également consulter les autres onglets de la boîte de dialogue AutoCorrection afin 
de découvrir toutes les autres options disponibles et, éventuellement, de les adapter à vos be-
soins.
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Conseil

L’AutoCorrection peut être utilisée comme un moyen rapide d’insérer des caractères spé-
ciaux. Par exemple, (c) sera remplacé automatiquement par ©. Vous pouvez également 
ajouter d’autres caractères spéciaux à la liste.

LibreOffice possède une liste étendue de caractères spéciaux accessibles par l’AutoCorrec-
tion. Par exemple, tapez :ampoule électrique: et l’AutoCorrection le remplacera par .  💡

Utiliser l’insertion automatique

Si l’insertion automatique est activée, Writer tente de déterminer quel est le mot que vous êtes en 
train de saisir et vous propose de compléter le mot pour vous. Pour accepter la suggestion du logi-
ciel, appuyez sur la touche Entrée de votre clavier. Si la suggestion ne vous convient pas, conti-
nuez à saisir le mot.

Pour désactiver l’insertion automatique, sélectionnez Outils > AutoCorrection > Options d’Auto-
Correction dans la barre de menu puis ouvrez l’onglet Insertion automatique où vous pourrez dé-
cocher l’option Activer l’insertion automatique.

Figure 18 : l’onglet Insertion automatique dans la boîte de dialogue AutoCorrection.

Il est possible de personnaliser l’insertion automatique via l’onglet de même nom de la boîte de 
dialogue AutoCorrection. Vous pouvez :

• ajouter un espace automatiquement après le mot que vous venez d’accepter ;
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• afficher sous forme d’infobulle la suggestion plutôt que de l’afficher dans le texte que vous
saisissez ;

• collecter les mots lorsque vous travaillez dans un document et les garder en mémoire afin 
de les utiliser dans d’autres documents. Toutefois, vous pouvez décider de supprimer la liste 
des mots lorsque vous fermerez le document ;

• modifier le maximum d’entrées à enregistrer pour la complétion des mots ainsi que la lon-
gueur minimum des mots à sauvegarder ;

• supprimer certaines entrées de la liste des mots disponibles pour l’insertion automatique ;

• modifier la touche qui vous permet d’accepter la suggestion. Les touches possibles sont : 
Flèche vers la droite, Fin, Entrée, Barre d’espace et Tabulation.

Remarque

L’insertion automatique ne s’active que si vous avez saisi au moins deux fois le même mot 
dans un même document.

Utiliser l’AutoTexte

Les AutoTextes permettent d’enregistrer du texte, des tableaux, des champs ainsi que d’autres élé-
ments que vous utilisez de manières récurrentes. Vous pourrez les lier à des raccourcis qui facilite-
ront leur utilisation.

Par exemple, au lieu de chaque fois saisir la formule de politesse “Je vous prie d’agréer, Madame, 
Monsieur, mes salutations distinguées.” dans un courrier, vous pouvez paramétrer un AutoTexte 
afin de simplement saisir le raccourci “sd” et appuyer sur la touche F3 pour insérer la phrase com-
plète dans votre document.

Les AutoTextes sont particulièrement utiles lorsqu’ils sont affectés à des champs. Pour plus d’infor-
mation sur les champs, référez-vous au chapitre 14, Travailler avec les champs, du Guide Writer.

Créer un AutoTexte

Pour enregistrer du texte comme AutoTexte :

 1) Saisissez le texte dans votre document.

 2) Sélectionnez le texte.

 3) Choisissez Outils > AutoTexte dans la barre de menu (ou appuyez sur les touches 
Ctrl+F3 de votre clavier).

 4) Dans la boîte de dialogue AutoTexte, saisissez un nom pour l’AutoTexte dans le champ Nom.
Dans le champ Raccourci, Writer vous suggérera un raccourci que vous pourrez éventuelle-
ment modifier.

 5) Dans la liste en dessous des champs Nom et Raccourci, choisissez la catégorie dans la-
quelle enregistrer l’AutoTexte. Par exemple, optez pour la catégorie Mes AutoTextes.

 6) En bas de la boîte de dialogue, cliquez sur le bouton AutoTexte et sélectionnez, dans le 
sous-menu, soit Nouveau (si vous souhaitez que votre AutoTexte conserve son formatage, 
peu importe l’endroit où il sera inséré), soit Nouveau (texte seulement) (si vous souhaitez 
que votre AutoTexte reprenne le formatage de l’emplacement où il sera inséré).

 7) Cliquez sur le bouton Fermer pour retourner au document.
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Conseil

Si la seule option possible dans le sous-menu du bouton AutoTexte est Importer, soit vous 
n’avez pas donné un nom à l’AutoTexte, soit aucun texte n’a été sélectionné dans le docu-
ment.

Insérer un AutoTexte

Pour insérer un AutoTexte, saisissez le raccourci dans votre document et appuyez ensuite sur la 
touche F3 de votre clavier.

Formater du texte

Il existe deux moyens de base pour mettre un texte en forme. La bonne compréhension de ces 
deux possibilités est essentielle pour tirer profit de la puissance de LibreOffice.

Mise en forme directe (ou manuelle)

Elle applique directement le formatage à des paragraphes, des caractères, des cadres, des 
listes ou des tableaux particuliers. Vous pouvez, par exemple, sélectionner un mot puis cli-
quez sur un bouton de la barre d’outils Formatage pour mettre le mot en gras ou en italique.

Styles

Ils regroupent sous un nom unique plusieurs options de formatage. Par exemple, un style de 
paragraphe définit de nombreux paramètres pour des options telles que la police et la taille 
des caractères, les mises en retrait du paragraphe, l’interligne, l’alignement du paragraphe 
sur la page et bien d’autres encore.

Il est recommandé d’utiliser les styles

Dès sa conception, les styles ont été au cœur de Writer. Cela signifie qu’il peut fonctionner de ma-
nière quelque peu différente d’autres programmes de traitement de texte qui vous sont familiers. Il 
demande quelques préparations, mais le temps qui leur est consacré peut faire économiser des ef-
forts et de la frustration à long terme.

Puisque les styles appliquent tout un ensemble de formatages en une seule fois, ils permettent de 
donner facilement une cohérence à la mise en forme d’un document avec un minimum d’efforts. 
En outre, les styles sont utilisés par LibreOffice pour toute une série de processus, même si vous 
n’en avez même pas conscience. Par exemple, Writer s’appuie sur les styles de titre (ou tout autre 
style que vous auriez défini) quand il compile une table des matières.

Writer définit six types de styles différents : paragraphes, caractères, pages, cadres, listes et ta-
bleaux. Pour plus d’informations sur les styles, référez-vous au chapitre 3, Utiliser les styles et les 
modèles, de ce guide ainsi qu’aux chapitres 6 et 7 du Guide Writer.

Formater des paragraphes grâce aux styles

Il est possible d’appliquer un style à un paragraphe en utilisant la liste déroulante située à l’extré-
mité droite de la barre d’outils Format, en utilisant l’onglet Styles et formatage du volet latéral ou le 
menu Styles.
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Vous pouvez utiliser les raccourcis clavier Ctrl+1 à Ctrl+5 pour appliquer les styles de 
paragraphe Titre 1 à Titre 5 et Ctrl+0 pour appliquer le style Corps de texte.

Vous avez aussi la possibilité d’ouvrir une barre d’outils permettant un accès facile à de nombreux 
styles en sélectionnant Affichage > Barres d’outils > Formatage (Styles) dans la barre de menu.

Figure 19 : la barre d’outils Formatage (Styles)

Formater directement des paragraphes

Vous pouvez appliquer de nombreux formats aux paragraphes en utilisant les boutons de la barre 
de Formatage ou en recourant au panneau Paragraphe de l’onglet Propriétés du volet latéral. Tous
les boutons de la barre d’outils ne sont pas visibles dans l’installation par défaut, mais il vous est 
possible de la personnaliser en y ajoutant vos fonctions préférées. Vous retrouverez notamment 
les boutons ci-dessous.

• Appliquer le style.

• (Dés)activer les puces (accompagné d’une palette de styles de puces).

• (Dés)activer la numérotation (accompagné d’une palette de styles de numérotation).

• Aligner à gauche ou droite, centrer horizontalement ou justifier.

• Aligner au-dessous ou en dessous ou centrer verticalement.

• Interligne (valeurs 1, 1,15, 1,5, 2 disponibles ou personnaliser l’interligne).

• Augmenter ou diminuer l’espacement des paragraphes.

• Augmenter ou diminuer le retrait.

• Paragraphe (pour ouvrir la boîte de dialogue Paragraphe).

! Attention

Le formatage manuel (aussi appelé formatage direct) prend le dessus par rapport aux 
styles, et vous ne pourrez plus l’effacer en appliquant un style.

Conseil

Pour supprimer un formatage manuel, sélectionnez le texte, effectuez un clic droit et choisis-
sez l’option Effacer le formatage direct dans le menu contextuel. Cette option est égale-
ment disponible depuis le menu Format > Effacer le formatage direct, en cliquant sur le 
bouton Effacer le formatage direct  de la barre de Formatage ou en appuyant sur les 
touches Ctrl+M de votre clavier. Le texte prend alors les styles de paragraphe et de carac-
tère appliqués et non les styles par défaut.
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Formater les caractères grâce aux styles

Pour appliquer un style à des caractères, sélectionnez-les et sélectionnez un style dans le menu 
Styles, dans le panneau Styles de caractères de l’onglet Styles et formatage du volet latéral ou 
dans le menu contextuel qui s’ouvre par un clic droit.

Formater directement des caractères

Il est recommandé d’utiliser autant que possible des styles de caractères plutôt qu’une mise en 
forme directe telle qu’elle est décrite dans cette section.

Vous pouvez appliquer de nombreux formats aux caractères en utilisant les boutons de la barre de
Formatage ou en recourant au panneau Caractère de l’onglet Propriétés du volet latéral. Tous les 
boutons de la barre d’outils ne sont pas visibles dans l’installation par défaut, mais il vous est pos-
sible de la personnaliser en y ajoutant vos fonctions préférées. Vous retrouverez notamment les 
boutons ci-dessous.

• Nom et taille de la police.

• Gras, italique, soulignage, double soulignage, surligné, barré ou contour des caractères.

• Indice ou exposant.

• Majuscule ou minuscule.

• Agrandir ou réduire la taille de la police.

• Couleur de police (accompagné d’une palette de couleurs).

• Couleur d’arrière-plan (accompagné d’une palette de couleurs).

• Surlignage (accompagné d’une palette de couleurs).

• Caractère (pour ouvrir la boîte de dialogue Caractère).

Remarque

La même remarque qu’au sujet du formatage direct des paragraphes s’applique à celui des 
caractères : il remplace le style de caractère en cours.

Formatage des tableaux

Dans les documents Writer, les tableaux disposent des mêmes paramètres de mise en forme que 
les feuilles de calcul dans LibreOffice Calc.

Pour appliquer un style à un tableau, placez le curseur dans celui-ci et sélectionnez Tableau > 
Styles d’AutoFormat… dans la barre de menu puis choisissez le style qui vous convient dans la 
boîte de dialogue qui s’ouvre alors. Après avoir placé le curseur dans le tableau, vous pouvez aus-
si faire un double clic sur un des styles proposés dans le panneau Styles de tableau de l’onglet 
Styles et formatage du volet latéral. Pour plus d’information, veuillez vous reporter au Guide Writer.

Formatage automatique grâce à l’AutoCorrection

Vous pouvez paramétrer Writer pour formater ou corriger automatiquement certaines parties d’un 
document pendant la frappe, en définissant certains critères dans la boîte de dialogue AutoCorrec-
tion (onglet Options) accessible via le menu Outils > AutoCorrection > Options d’AutoCorrec-
tion…
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Si vous remarquez une modification de formatage inattendue, c’est le premier endroit où en 
chercher la cause. Dans la plupart des cas, il suffit d’annuler (Ctrl+Z) la dernière action 
pour résoudre le problème.

L’Aide décrit chacun de ces choix et comment activer les formatages automatiques. Parmi les mo-
difications courantes non souhaitées et inattendues, on trouve :

• les lignes horizontales. Si vous saisissez plus de deux tirets (---), traits de soulignements (_
_ _) ou signes égal (===) en début de ligne et que vous appuyez ensuite sur la touche 
Entrée de votre clavier, le paragraphe est alors remplacé par une ligne horizontale aussi 
large que la page ou la colonne moins le retrait du paragraphe précédent dont la ligne est en 
réalité la bordure inférieure ; 

• les listes à puces et numérotées. Une liste à puces est créée lorsque vous saisissez un ti-
ret (-), un astérisque (*) ou le signe plus (+), suivi par un espace ou une tabulation au début 
d’un paragraphe. Une liste numérotée est créée lorsque vous saisissez un nombre suivi par 
un point (.), suivi par un espace ou une tabulation au début d’un paragraphe. Cette numéro-
tation automatique n’est appliquée qu’aux paragraphes dont le style est Standard, Corps de 
texte ou Retrait de corps de texte.

Pour (dés)activer le formatage automatique, sélectionnez Outils > AutoCorrection > Options 
d’Autocorrection… dans la barre de menu et (dé)cochez les éléments dans la liste de l’onglet 
Options.

Créer des listes grâce aux styles

Créer des listes à puces ou numérotées

Utilisez, chaque fois que possible, un style de paragraphe pour créer une liste à puces ou numéro-
tée. Writer offre pour cela deux jeux de styles de paragraphe. Ceux-ci ne possèdent cependant 
pas d’options pour paramétrer des choses comme le type de puce ou la position des nombres. 
Ces réglages proviennent des styles de liste qui sont différents des styles de paragraphe. Il est re-
commandé de les utiliser ensemble de la manière suivante :

• utilisez les styles de paragraphe Puce 1, Puce 2, Puce 3, etc. pour créer des listes à puces. 
Ils utilisent des styles de liste qui portent le même nom ;

• utilisez les styles de paragraphe Numérotation 1, Numérotation 2, Numérotation 3, etc. pour 
créer des listes numérotées. Ils utilisent des styles de liste qui portent le même nom.

Pour associer un style de paragraphe à un style de liste, sélectionnez Styles > Gérer les styles 
dans la barre de menu ou appuyez sur F11 pour ouvrir la liste des styles dans le volet latéral. 
Faites un clic droit sur le style de paragraphe puis choisissez Modifier… dans le menu contextuel. 
Faites votre choix dans la liste déroulante Style de numérotation de l’onglet Plan & numérotation.

Les styles de paragraphe tels que Puce 1 début ou Puce 1 fin vous permettent d’ajuster les pro-
priétés particulières (comme, par exemple, l’espace entre les paragraphes) pour le premier et le 
dernier élément de la liste.
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Remarque

Les styles de liste ne sont pas destinés à être utilisés seuls, mais plutôt à être attachés à 
des styles de paragraphe.

Créer des listes imbriquées

Avec les styles de paragraphe, il est facile de créer des listes imbriquées où les entrées ont des 
subdivisions comme dans un plan. Cela demande de spécifier les paramètres des niveaux supplé-
mentaires. Pour cela, faites un clic droit sur le style de liste (pas le style de paragraphe) et définis-
sez l’apparence de chaque niveau dans l’onglet Personnaliser ainsi que leur position et leur retrait 
dans l’onglet Position. Reportez-vous au Guide Writer pour les détails.

Une fois la liste imbriquée paramétrée, vous pouvez immédiatement déplacer une entrée dans la 
hiérarchie. Pour abaisser une entrée d’un niveau, placez le curseur au début de la ligne (après la 
puce ou le numéro) et appuyez sur la touche Tabulation. Pour la hausser d’un niveau, appuyez 
sur les touches Maj+Tabulation.

Créer des listes par formatage direct

Créer des listes à puces ou numérotées

Il y a plusieurs façons de créer des listes numérotées ou des listes à puces :

• utiliser le formatage automatique par l’AutoCorrection, comme décrit ci-dessus ;

• utiliser les boutons Numérotation  et Puces  dans la barre d’outils Formatage ;

• utiliser le panneau Paragraphe de l’onglet Propriétés du volet latéral.

Remarque

Les puces et numéros appliqués de cette façon ne peuvent pas être supprimes par la com-
mande Effacer le formatage direct du menu Format ni par le raccourci clavier Ctrl+M. 
Leur état d’activation est inversé en cliquant sur les boutons Puces et Numérotation de la 
barre d’outils Formatage ou de l’onglet Propriétés du volet latéral.

Créer des listes imbriquées

Vous pouvez créer des listes imbriquées (où un élément d’une liste ou plus a une sous-liste, 
comme dans un plan) en utilisant les boutons de la barre d’outils Puces et numérotations (voir Fi-
gure 20). Vous pouvez déplacer les éléments vers le bas ou le haut, ou créer des sous-points ou 
même modifier le style de la puce. Utilisez Affichage > Barres d’outils > Puces et numérota-
tions pour afficher la barre d’outils.

Remarque

Si la numérotation ou les puces sont automatiquement appliquées d’une façon qui ne vous 
convient pas, vous pouvez la désactiver en décochant l’option Outils > AutoCorrection > 
Pendant la frappe.

Les boutons Puces et Numérotation disponibles dans le panneau Paragraphe de l’onglet Proprié-
tés du volet latéral peuvent également être utilisés pour configurer des listes imbriquées et accéder
à la boîte de dialogue Puces et numérotation. Toutefois, le volet latéral n’inclut pas les outils pour 
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hausser ou abaisser d’un niveau les éléments de la liste comme le propose la barre d’outils Puces 
et numérotation.

Abaisser d’un niveau Hausser d’un niveau Abaisser d’un niveau 
(avec les sous-niveaux)

Hausser d’un niveau (avec
les sous-niveaux)

Déplacer vers le bas de la 
liste

Déplacer vers le haut de la
liste

Déplacer vers le bas (avec
les sous-niveaux)

Déplacer vers le haut 
(avec les sous-niveaux)

Insérer une entrée sans 
numéro

Recommencer la numéro-
tation

Ouvrir la boîte de dialogue
Puces et numérotation.

Figure 20 : La barre d’outils Puces et numérotation.

Définir des tabulations et des retraits

La règle horizontale affiche à la fois les tabulations par défaut ainsi que toutes les tabulations que 
vous avez définies et qui les remplacent. Les paramètres d’une tabulation affectent le retrait d’un 
paragraphe entier (en utilisant les icônes Augmenter le retrait ( ) et Réduire le retrait ( ) de 
la barre d’outils Formatage) et les tabulations présentes dans un paragraphe (en appuyant sur la 
touche Tabulation de votre clavier).

L’utilisation de l’intervalle de tabulation par défaut peut poser des problèmes dans la mise en page 
de votre document si vous le partagez avec d’autres personnes. En effet, si vous employez l’inter-
valle de tabulation par défaut et que le destinataire de votre document en a choisi un différent du 
vôtre, vos tabulations seront modifiées selon les paramètres du destinataire. Par conséquent, au 
lieu de recourir aux tabulations par défaut, il est préférable que vous définissiez vos propres tabu-
lations comme décrit dans cette section.

Pour paramétrer les tabulations et les retraits d’un ou plusieurs paragraphes sélectionnés, faites 
un double clic entre les icônes qui permettent de régler le retrait à gauche et à droite sur la règle 
horizontale afin d’ouvrir l’onglet Tabulations de la boîte de dialogue Paragraphe ou double-cliquez 
sur une partie de la règle horizontale qui n’est pas entre ces icônes pour ouvrir l’onglet Retraits et 
espacement de la même boîte de dialogue.

Une meilleure alternative consiste à définir les tabulations pour le style de paragraphe. Pour plus 
d’informations sur les styles, référez-vous aux chapitres 6 et 7 du Guide Writer.

Conseil

Utiliser des tabulations pour espacer des éléments sur un document n’est pas recommandé.
Selon ce que vous souhaitez réaliser, un tableau sans bordures peut s’avérer être un 
meilleur choix que l’utilisation de tabulations.
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Définir l’intervalle de tabulation par défaut

! Attention

Toute modification apportée à l’intervalle de tabulation par défaut affectera tous les inter-
valles de tabulation présents dans n’importe quel document créé auparavant. De la même 
façon, toute nouvelle tabulation insérée après la modification sera également affectée.

Pour configurer l’Unité de mesure ainsi que l’Espace entre les tabulations par défaut, Outils > Op-
tions dans la barre de menu et ouvrez la page LibreOffice Writer – Général dans la boîte de dia-
logue Options.

Figure 21. Paramétrer l’espace par défaut entre les tabulations.

Vous pouvez également paramétrer l’unité de mesure des
règles dans le document actif en effectuant un clic droit sur
l’une des règles pour afficher la liste des unités de mesure.
Cliquez sur l’unité de mesure désirée pour l’activer. À noter
que l’unité de mesure choisie s’applique uniquement à la
règle sur laquelle vous l’avez activée.

Coupure des mots

Vous avez plusieurs choix en ce qui concerne la coupure des
mots : laisser Writer le faire automatiquement (grâce à son
dictionnaire de césure), insérer manuellement des tirets
conditionnels où vous le souhaitez, ou ne pas couper les mots du tout. Chaque choix présente des
avantages et des inconvénients.

Coupure automatique des mots grâce aux styles

Pour (dés)activer la coupure des mots automatique :

 1) Appuyez sur la touche F11 (⌘+T sur Mac) de votre clavier pour ouvrir l’onglet Styles et for-
matage du volet latéral. Si celui-ci est ouvert, il suffit de cliquer sur l’icône Styles et forma-
tage  pour ouvrir l’onglet correspondant. Ouvrez le panneau Styles de paragraphe (pre-
mier bouton en haut à gauche de l’onglet).

 2) Dans la fenêtre Styles et formatage (voir Figure 23), faites un clic droit sur le Style par défaut
et cliquez sur Modifier dans le menu contextuel.
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Figure 23. Modifier un style.

 3) Dans la boîte de dialogue Style de paragraphe (voir Figure 24), ouvrez l’onglet Enchaîne-
ments.

 4) Sous la section Coupure des mots, (dé)cochez l’option Automatiquement. Cliquez ensuite 
sur le bouton OK pour enregistrer les modifications.

Figure 24. Activer la coupure des mots automatique.

Remarque

Activer la coupure des mots pour le style de paragraphe par défaut affecte tous les para-
graphes basés sur le style par défaut. Les styles non basés sur le style par défaut (un style 
de titre par exemple) ne seront pas affectés par cette modification, à moins que vous ne pa-
ramétriez également leur style de paragraphe. 

Pour plus d’information sur les styles de paragraphe, référez-vous au chapitre 3, Utiliser les 
styles, de ce guide.

Configurer la coupure de mots dans les paramètres linguistiques

Vous pouvez configurer les paramètres de coupure des mots dans la page Paramètres linguis-
tiques – Linguistique de la boîte de dialogue Options (via le menu Outils > Options). Dans la sec-
tion Options, recherchez les paramètres relatifs à la coupure des mots.
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Figure 25. Paramètres relatifs à la coupure des mots.

Pour modifier le nombre minimum de caractères pour la coupure des mots ou le nombre minimum 
de caractères avant/après la séparation, sélectionnez l’élément concerné puis cliquez sur le bou-
ton Éditer.

Remarque

Les options inhérentes à la coupure des mots paramétrées dans la page Paramètres lin-
guistiques – Linguistique de la boîte de dialogue Options ne seront effectives que si la cou-
pure des mots est activée dans les styles de paragraphe.

Coupure manuelle des mots

Lors d’une coupure des mots manuelle, n’utilisez pas un tiret normal. Ce dernier resterait visible 
même si le mot n’a plus à être coupé à la suite d’un ajout ou d’une suppression de texte, d’une 
modification des marges ou de la taille de la police. Utilisez plutôt un Tiret conditionnel.

Pour insérer un tiret conditionnel à l’intérieur d’un mot, cliquez dans le mot à l’endroit où vous sou-
haitez que celui-ci apparaisse et appuyez ensuite sur les touches Ctrl+Signe moins (le moins 
du pavé numérique) de votre clavier ou sélectionnez Insertion > Marque de formatage > Césure 
dans la barre de menu. Le mot sera coupé à l’endroit choisi lorsqu’il se retrouvera à la fin d’une 
ligne, même si la coupure automatique des mots est désactivée pour le paragraphe.

Formater les pages

Dans Writer, toute page est basée sur un style. Les styles de page définissent la disposition de 
base, dont la taille de la page, les marges, les en-têtes et pieds de page, les bordures, l’arrière-
plan, etc. Une modification de ces paramètres change automatiquement le style de page. Cela si-
gnifie que, contrairement aux styles de paragraphe, ces paramètres ne peuvent pas être utilisés di-
rectement pour formater des pages particulières.

Comme pour les autres styles, Writer propose un certain nombre de styles de page. Vous pouvez 
les modifier ou créer les vôtres. Le style de page par défaut est utilisé quand aucun autre n’a été 
spécifié. En plus des styles de page, Writer offre plusieurs autres fonctions qui permettent d’avoir 
un contrôle plus complet sur la mise en page : les colonnes, les cadres, les tableaux et les sec-
tions. Pour plus d’informations, référez-vous au chapitre 4, Formater les pages, du Guide Writer.

Conseil

Habituellement, la mise en page est plus simple si vous affichez les limites du texte, des ob-
jets, des tableaux et des sections via la page LibreOffice – Couleurs de l’interface de la boîte
de dialogue Options (Outils > Options). L’affichage des marques de paragraphes, des ta-
bulations et des sauts est accessible dans la page LibreOffice Writer – Aides au formatage 
de la même boîte de dialogue.
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Quelle méthode de mise en page choisir ?

La meilleure méthode de mise en page dépend de l’apparence finale du document ou des informa-
tions que contient le document.

Vous souhaitez réaliser un
livre similaire au présent 
guide contenant une seule
colonne de texte, 
quelques illustrations non 
entourées de texte ainsi 
que des légendes. Pour ce
faire, recourez de préfé-
rence aux styles de mise 
en page basiques, aux ta-
bleaux pour y placer une 
image ainsi qu’une éven-
tuelle description.

Vous souhaitez réaliser un
index ou tout autre docu-
ment contenant deux co-
lonnes de texte s’étalant 
de gauche à droite et de 
page en page. Pour ce 
faire, recourez de préfé-
rence aux styles de mise 
en page à deux colonnes. 
Si le titre du document 
(première page) s’affiche 
sur toute la largeur de la 
page, placez-le dans une 
section à une colonne.
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Vous souhaitez réaliser un
bulletin d’information dont 
la mise en page complexe 
contient deux ou trois co-
lonnes par page ainsi que 
quelques articles qui 
prennent plusieurs pages. 
Pour ce faire, recourez de 
préférence aux styles de 
mise en page basiques, 
placez les articles dans 
des cadres liés ainsi que 
des ancres pour les objets
à disposer.

Vous souhaitez réaliser 
une liste de vocabulaire 
avec sa traduction en vis-
a-vis. Pour ce faire, recou-
rez de préférence aux 
styles de mise en page à 
une colonne et créez un 
tableau (dont vous pouvez
modifier les bordures) 
pour y placer chaque mot 
de vocabulaire.

Créer des en-têtes et pieds de page

Un en-tête est une zone qui apparaît en haut de la page, au-dessus de la marge. Le pied de page 
est une zone qui apparaît au bas de la page, en dessous de la marge. Les informations contenues 
dans les en-têtes et pieds de page (par exemple, le numéro de page ou le titre du document) s’af-
fichent sur toutes les autres pages du document qui possède le même style (sauf si le style de 
page autorise un paramétrage différent pour la première page ou pour les pages de droite et de 
gauche).
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Remarque

Un en-tête ou un pied de page sont des propriétés d’un style de page. Activez ou désacti-
vez-les séparément pour chaque style de page utilisé dans votre document.

Insérer un en-tête ou un pied de page

Tout ce qui est dit ici pour les en-têtes s’applique de façon identique pour les pieds de page.

Pour insérer un en-tête (ou un pied de page), plusieurs méthodes sont possibles :

• sélectionner Insertion > En-tête et pied de page > En-tête > Style par défaut (ou tout 
autre style disponible) dans la barre de menu ;

• cliquer au-dessus de la zone de texte pour faire apparaître la délimitation de l’en-tête (voir Fi-
gure 26). Cliquez ensuite sur le sigle + ;

Figure 26. La délimitation de l’en-tête en haut de la zone de texte.

Lorsque vous avez créé l’en-tête, une flèche vers le bas apparaît dans la délimitation de l’en-tête. 
Cliquez dessus pour afficher le menu de l’en-tête (voir Figure 27).

Figure 27. Le menu En-tête.

Définir l’apparence d’un en-tête ou d’un pied de page

Pour mettre en forme un en-tête (la procédure est semblable pour un pied de page), vous pouvez 
sélectionner soit Formater l’en-tête… dans le menu visible sur la Figure 27 soit Format > Page 
dans le menu principal puis ouvrir l’onglet En-tête dans la boîte de dialogue Style de page.

Dans cet onglet, vous pouvez définir si l’en-tête doit être identique ou différent sur les pages de 
droite et de gauche, si la première page doit en avoir un et s’il doit être différent de celui des autres
pages.

C’est aussi là que vous pouvez décider d’afficher ou non l’en-tête et en paramétrer les marges et 
l’espace entre celui-ci et le texte du document.
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Figure 28 : l’onglet En-tête de la boîte de dialogue Style de page.

Insérer du contenu dans les en-têtes et pieds de page

Des informations telles que le titre du document ou du chapitre sont souvent placées dans les en-
têtes et les pieds de page. Il est préférable de recourir aux champs pour ajouter ces renseigne-
ments. De cette façon, si une information est modifiée, les en-têtes et pieds de page seront adap-
tés automatiquement.

Voici la procédure pour insérer, par exemple, le titre du document dans l’en-tête :

 1) Si ce n’est déjà fait, sélectionnez Fichier > Propriétés dans la barre de menu, ouvrez l’on-
glet Description et saisissez le titre de votre document.

 2) Ajouter un en-tête à votre document (menu Insertion > En-tête et pied de page > En-tête >
Style par défaut ou le style de la page courante).

 3) Placez le pointeur de la souris dans l’en-tête de la page. Si nécessaire, cliquez sur le + pour 
pouvoir cliquer ensuite dans l’en-tête.

 4) Sélectionnez Insertion > Champs > Titre dans la barre de menu. Le titre s’affiche avec un 
arrière-plan grisé (qui n’apparaît pas à l’impression du document et peut être masqué dans 
la page LibreOffice – Couleurs de l’interface de la boîte de dialogue Options (Outils > Op-
tions)).

 5) Pour modifier le titre de tout le document, retournez dans le menu Fichier > Propriétés > 
Description.

Les champs sont abordés en détail dans le chapitre 17, Travailler avec les champs, du Guide 
Writer. Pour plus d’informations relatives aux en-têtes et pieds de page, référez-vous aux chapitres
5, Mettre les pages en forme, et 8, Introduction aux styles, du Guide Writer.

Numéroter les pages

Afficher le numéro de page

Pour afficher automatiquement le numéro de page :
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 1) Insérer un en-tête ou un pied de page comme décrit dans la section « Insérer un en-tête ou
un pied de page » ci-dessus.

 2) Placez le pointeur de la souris dans l’en-tête ou le pied de page à l’endroit où vous souhaitez
que le numéro de page apparaisse et cliquez sur le menu Insertion > Numéro de page.

Afficher le nombre de pages

Pour afficher automatiquement le nombre de pages (comme dans “page 1 sur 12”) :

 1) Saisissez le mot “page” suivi d’un espace et insérez le numéro de page comme décrit ci-
avant.

 2) Saisissez un espace suivi du mot “sur” à nouveau suivi d’un espace et cliquez sur le menu 
Insertion > Champs > Nombre de pages.

Remarque

Le champ Nombre de pages affiche le nombre total de pages contenues dans le document 
comme l’affichent les propriétés du document (accessibles via le menu Fichier > Propriétés
> Statistiques). Si vous redémarrez la numérotation des pages quelque part dans le docu-
ment, le total des pages pourrait ne pas correspondre à vos besoins. Pour plus d’informa-
tions, référez-vous au chapitre 5, Mettre les pages en forme, du Guide Writer.

Recommencer la numérotation des pages

Il est fréquent de recommencer la numérotation d’une page à 1, par exemple après une page de 
titre ou une table des matières. En outre, de nombreux documents contiennent une préface ou une
table des matières numérotée avec des chiffres romains alors que le reste du document est numé-
roté avec des chiffres arabes.

Pour recommencer la numérotation des pages, deux méthodes sont possibles :

Méthode 1 :

 1) Placez le pointeur de la souris dans le premier paragraphe de la nouvelle page.

 2) Sélectionnez Format > Paragraphe dans la barre de menu

 3) Dans l’onglet Enchaînements de la boîte de dialogue Paragraphe (voir Figure 24 en page
32), intéressez-vous à la section Sauts.

 4) Cochez l’option Insérer puis l’option Avec le style de page et spécifiez le style de page à utili-
ser.

 5) Spécifiez si nécessaire le Numéro de page à partir duquel la numérotation doit recommencer
puis cliquez sur le bouton OK.

Méthode 2 :

 1) Sélectionnez Insertion > Saut manuel dans la barre de menu.

Par défaut, Saut de page est sélectionné dans la boîte de dialogue Insérer un saut (voir Fi-
gure 29).

38 | Débuter avec Writer



Figure 29. Recommencer la numérotation après un saut manuel.

 2) Choisissez le Style de page souhaité.

 3) Cochez l’option Modifier le numéro de page.

 4) Spécifiez le numéro de page et cliquez sur le bouton OK.

Conseil

La méthode 1 est également utile pour numéroter la première page d’un document avec un 
numéro plus grand que 1. Imaginons que vous écrivez un livre dont chaque chapitre fait l’ob-
jet d’un fichier différent. Le chapitre 1 commencera à la page 1, mais le chapitre 2 pourrait 
commencer à la page 25 et le chapitre 3 à la page 51.

Modifier les marges de la page

Pour modifier les marges d’une page, trois méthodes sont possibles :

• utiliser les règles de la page : rapide et facile, mais peu précis ;

• utiliser la boîte de dialogue Style de page : les marges sont paramétrées précisément ;

• utiliser l’onglet Page du volet latéral.

! Attention

Les modifications apportées aux marges s’appliqueront à toutes les pages utilisant le même
style, car c’est le style de page qui est directement affecté. Si vous ouvrez la boîte de dia-
logue Style de page, vous y verrez les nouveaux paramètres des marges.

Pour modifier les marges en utilisant les règles :

 1) Les parties grisées des règles représentent les marges. Placez le curseur de la souris au-
dessus de la ligne située entre la partie grisée et la partie blanche. Le pointeur se transforme
en une double flèche et affiche les paramètres actuels dans une infobulle.

 2) Cliquez sur le bouton gauche de la souris et glissez-la pour déplacer les marges.
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Figure 30. Déplacer les marges.

! Attention

Les petites flèches grisées situées sur les règles sont utilisées pour les retraits de para-
graphes. Ils se trouvent souvent au même endroit que les marges de la page. Par consé-
quent, soyez prudent lorsque vous déplacez les marges afin de ne pas modifier les retraits 
de paragraphes. La double flèche visible sur la Figure 30 indique que vous pouvez déplacer 
les marges.

Pour modifier les marges en utilisant la boîte de dialogue Style de page :

 1) Faites un clic droit n’importe où sur la page et cliquez sur Page… dans le menu contextuel.

 2) Dans l’onglet Page de la boîte de dialogue Style de page, indiquez la taille des marges sou-
haitée dans les zones correspondantes.

Pour modifier les marges en utilisant l’onglet Page du volet latéral :

 1) Si ce n’est déjà fait, affichez le volet latéral (menu Affichage > Volet latéral) et cliquez sur 
l’icône de l’onglet Page.

 2) Dans le panneau Format, sélectionnez les marges souhaitées dans la liste déroulante 
Marges. Cliquez sur le bouton Plus d’options ( ) pour ouvrir la boîte de dialogue Style de 
page où vous pourrez saisir des valeurs plus précises.

Ajouter un filigrane personnalisé à l’arrière-plan de la page

Pour ajouter un filigrane à l’arrière-plan d’une page :

 1) Sélectionnez Format > Filigrane… dans la barre de menu.

 2) Dans la boîte de dialogue Filigrane (Figure 31), tapez le texte et choisissez la police, l’angle, 
la transparence et la couleur du filigrane puis cliquez sur le bouton OK.

Remarque

Le filigrane fera automatiquement partie du style de la page où il est inséré, et toutes les 
autres pages du même style l’afficheront aussi. Pour afficher un autre filigrane ou aucun fili-
grane sur certaines pages, il faut qu’elles utilisent un autre style.
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Figure 31 : la boîte de dialogue Filigrane

Ajouter des commentaires dans un document

Writer propose un type de commentaires que l’on pourrait appeler “notes” ou « pense-bêtes ». Les 
auteurs et les relecteurs l’utilisent fréquemment pour échanger des idées, faire des suggestions, 
poser des questions ou lors d’une réunion remue-méninges.

Un commentaire peut cibler un bloc de texte ou un seul point du document. Pour insérer un com-
mentaire, sélectionnez le texte concerné ou placez votre curseur à l’endroit où vous souhaitez le 
faire apparaître. Choisissez ensuite Insertion > Commentaire dans la barre de menu ou appuyez 
sur les touches Ctrl+Alt+C de votre clavier. Le point d’ancrage du commentaire est connecté 
par une ligne pointillée à un cadre situé à droite de la page et dans lequel vous pouvez saisir le 
texte du commentaire. Un bouton Commentaires (encadré en vert sur la Figure 32), situé à l’ex-
trémité droite de la règle si des commentaires existent, vous permet de les afficher ou non.

Cliquez n’importe où dans la page, ou appuyez sur la touche Échap de votre clavier, pour indiquer 
à Writer que vous avez terminé d’éditer le commentaire. Autrement, vous ne pourrez pas quitter le 
cadre du commentaire.

Formater les commentaires

Writer indique automatiquement au bas du commentaire le nom de l’auteur ainsi que le moment de
sa création. Si plusieurs personnes rédigent des commentaires, chacune reçoit automatiquement 
une couleur de fond différente. La Figure 32 montre un document sur lequel des commentaires ont
été ajoutés par deux auteurs différents.

Figure 32. Les commentaires dans Writer.
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Pour modifier le nom d’auteur qui apparaît dans le commentaire, ouvrez la page LibreOffice – 
Données d’identité dans la boîte de dialogue Options Outils > Options dans la barre de menu) et 
complétez les rubriques Nom, Prénom et Initiales.

Faites un clic droit dans un commentaire afin d’ouvrir un menu déroulant dans lequel vous pourrez 
choisir de supprimer le commentaire actif, tous les commentaires d’un même auteur ou tous les 
commentaires du document. Cette partie du menu déroulant est également accessible en cliquant 
sur le bouton en bas à droite du commentaire. Depuis le menu déroulant, vous pouvez également 
répondre à l’auteur du commentaire et appliquer quelques formatages basiques au texte du com-
mentaire. Il vous est également possible d’utiliser les fonctions de la barre de formatage.

Naviguer parmi les commentaires

Pour passer d’un commentaire à un autre, ouvrez le navigateur depuis la barre d’outils standard ou
appuyez sur la touche F5 de votre clavier. Développez la section Commentaires et double-cliquez 
sur un des commentaires pour déplacer le curseur au point d’ancrage du commentaire. Cliquez sur
celui-ci pour le modifier ou faites un clic droit pour pouvoir le modifier ou le supprimer rapidement.

Vous pouvez également passer d’un commentaire à un autre en utilisant le clavier. Appuyez sur les
touches Ctrl+Alt+Page suivante pour passer au commentaire suivant ou sur les touches 
Ctrl+Alt+Page précédente pour revenir au commentaire précédent.

Imprimer les commentaires

Les commentaires peuvent être imprimés à côté du texte, tels qu’ils apparaissent dans la marge à 
l’écran. Chaque page est alors redimensionnée afin de laisser de la place aux commentaires (dans
une marge) sur le papier. La boîte de dialogue d’impression possède aussi des options pour placer
les commentaires en fin de page, en fin de document ou pour n’imprimer que ceux-ci.

Créer une table des matières

Writer permet de créer automatiquement une table des matières à partir des titres du document. 
Avant de commencer la rédaction de votre document, assurez-vous que les styles de titres soient 
cohérents. Par exemple, le style Titre 1 peut être affecté aux titres de chapitre tandis que les styles
Titre 2 et Titre 3 peuvent être attribués aux sous-titres du chapitre.

Bien qu’il soit possible de personnaliser significativement les tables de matières dans Writer, les 
paramètres par défaut s’avèrent la plupart du temps suffisants. Ainsi, la création d’une table des 
matières est simple :

 1) Lorsque vous rédigez votre document, recourez aux styles de paragraphes suivants Titre 1, 
Titre 2, Titre 3, etc. pour les différents niveaux de titres. En effet, ces styles apparaîtront plus 
tard dans votre table des matières.

 2) Placez le curseur de la souris à l’endroit où vous souhaitez que votre table des matières ap-
paraisse.

 3) Sélectionnez alors Insertion > Table des matières et Index > Table des matières, Index 
ou Bibliographie… dans la barre de menu.

 4) Ne modifiez aucun paramètre de la boîte de dialogue Insérer un index/une table et cliquez 
sur le bouton OK.
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Si vous ajoutez ou supprimez du texte de façon à ce que les titres changent de pages, ou si vous 
ajoutez, supprimez ou modifiez des titres, il vous faudra actualiser la table des matières. Pour 
cela :

 1) Placez le pointeur de la souris dans la table des matières.

 2) Faites un clic droit et cliquez sur Actualiser l’index ou la table des matières dans le menu 
contextuel.

Remarque

Si vous ne pouvez pas placer le pointeur de la souris dans la table des matières, ouvrez la 
page LibreOffice Writer – Aides au formatage de la boîte de dialogue Options (Outils > Op-
tions dans la barre de menu). Cochez ensuite l’option Activer le curseur dans la section 
Zones protégées.

Vous pouvez personnaliser une table des matières existantes à tout moment en faisant un clic droit
sur celle-ci, puis en cliquant sur Éditer l’index ou la table des matières dans le menu contextuel. 
Le chapitre 15, Tables des matières, index et bibliographies, du Guide Writer décrit en détail toutes
les personnalisations possibles.

Créer des index et des bibliographies

La création et la gestion d’index ou de bibliographies sont similaires à celles des tables des ma-
tières. Le chapitre 15, Tables des matières, index et bibliographies, du Guide Writer décrit en détail
toutes ces fonctions.

Outre les index alphabétiques, Writer offre d’autres types d’index, tels que les index relatifs aux 
illustrations, tableaux ou objets, et vous permet de générer des index personnalisés.

Par exemple, vous pouvez créer un index contenant uniquement le nom scientifique des espèces 
de plantes mentionnées dans le texte, ainsi qu’un index séparé contenant uniquement leurs noms 
communs. Avant d’entamer la création de tels index, il vous faut d’abord générer des entrées d’in-
dex incorporées dans votre document Writer.

Travailler avec des objets graphiques

Il existe trois types basiques d’objets graphiques dans Writer :

• les fichiers d’image (photos, dessins et images numérisées) ;

• les dessins créés à l’aide des outils de dessin de LibreOffice ;

• les diagrammes créés à l’aide du composant spécialisé de LibreOffice.

Pour plus d’informations, référez-vous au chapitre 11, Dessins, Galerie et Fontwork, de ce guide 
ainsi qu’au chapitre 11, Images et objets graphiques, du Guide Writer.

Imprimer

Référez-vous au chapitre 10, Imprimession, exportation et mailing, de ce guide ainsi qu’au chapitre
7, Imprimer, exporter, envoyer par courriel, du Guide Writer pour obtenir plus de détails sur l’aper-
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çu avant impression, les options d’impression disponibles, l’impression en noir et blanc sur une im-
primante couleur, l’impression de brochures, etc.

Utiliser le mailing

LibreOffice Writer fournit des moyens très utiles pour créer et imprimer :

• des copies multiples d’un document à envoyer à une liste de destinataires (lettre type) ;

• des étiquettes ;

• des enveloppes.

Toutes ces fonctions sont basées sur le concept de source de données (une feuille de calcul ou 
une base de données) depuis laquelle sont extraites les informations nécessaires au mailing (nom,
fonction, adresse, etc.) Le chapitre 7, Imprimer, exporter, envoyer par courriel,, du Guide Writer dé-
crit tout ce processus.

Suivre les modifications apportées à un document

Plusieurs méthodes sont possibles afin de suivre les modifications apportées à un document :

 1) Effectuez les modifications sur une copie du document (enregistré dans un dossier différent 
ou sauvegardé sous un autre nom). Utilisez ensuite Writer pour combiner les deux fichiers et 
vous montrer quelles modifications y ont été apportées. Pour cela, sélectionnez Édition > 
Suivi des modifications > Comparer le document dans la barre de menu. Cette technique
est particulièrement pratique si vous êtes la seule personne à travailler sur le document. En 
effet, elle évite d’augmenter la taille du fichier et s’avère moins complexe que les autres mé-
thodes.

 2) Enregistrez différentes versions du document (à des moments distincts) qui seront toutes 
stockées dans le fichier d’origine. Cette méthode peut toutefois poser des problèmes à 
cause de la taille du fichier, en particulier si vous sauvegardez de nombreuses versions. 
C’est pourquoi il vaut mieux, dans la mesure du possible, réserver cette méthode aux docu-
ments courts ou peu modifiés.

 3) Utilisez les marques de révision afin d’afficher clairement les modifications (ajout/suppres-
sion de texte et changement de formatage). Plus tard, une autre personne ou vous-même 
pourrez accepter ou rejeter les modifications apportées. Pour activer l’enregistrement des 
modifications, sélectionnez Édition > Suivi des modifications > Enregistrer dans la barre 
de menu. Pour afficher ou cacher les marques de révisions, sélectionnez Édition > Suivi 
des modifications > Afficher. Pour accepter ou rejeter une modification, faites un clic droit 
sur celle-ci puis sélectionnez Accepter la modification ou Rejeter la modification dans le 
menu contextuel. Vous pouvez aussi sélectionner Édition > Suivi des modifications > Gé-
rer... afin d’afficher la liste des modifications où vous pourrez les accepter ou les rejeter.

Conseil

Toutes les modifications ne sont pas enregistrées. Par exemple, des modifications appor-
tées à un taquet de tabulation (changer l’alignement à gauche en alignement à droite), à des
formules (équations) ou à des images liées ne peuvent pas être mémorisées.
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! Attention

Un document dont le suivi de modifications est actif et certaines modifications sont cachées 
conserve l’historique des modifications. Un utilisateur courant peut ne pas en avoir 
conscience, mais le contenu effacé ou modifié peut être rétabli. Bien que ce soit une pro-
priété délibérée, c’est aussi un moyen d’accès à l’historique du document.

Utiliser les champs

Les champs sont très utiles dans Writer et sont employés dans les documents à des fins diverses :
pour des données qui changent (la date du jour ou le nombre de pages), pour des données qui 
peuvent être modifiées (le titre du document, l’auteur ou la date de la dernière mise à jour). Les 
champs constituent la base des références (voir ci-après) telles que la numérotation automatique 
des illustrations, des tableaux, des titres ainsi que bien d’autres éléments et fonctions dont il n’est 
pas possible de faire la liste complète dans ce guide. Pour de plus amples informations, référez-
vous au chapitre 17, Travailler avec les champs, du Guide Writer.

Créer un lien ou un renvoi vers une autre partie du document

Dans un document, si vous faites référence à une autre partie du même document, celle-ci peut fa-
cilement devenir inexacte si vous réorganisez l’ordre des chapitres, ajoutez ou supprimez des élé-
ments, etc. Que vos références redirigent vers le même document ou un document externe, Writer
propose deux manières de vous assurer qu’elles seront mises à jour : les hyperliens et les renvois.

Quelle que soit la méthode utilisée, si vous faites Ctrl+clic sur le lien, vous serez redirigé vers 
sa cible. Ces deux méthodes ont toutefois des différences majeures :

• le texte d’un hyperlien n’est pas mis à jour automatiquement si vous modifiez le texte de 
l’élément ciblé (à moins que vous ne le modifiiez manuellement). Le texte d’un renvoi est ac-
tualisé ;

• si vous recourez à un hyperlien, le choix des cibles sera limité (tableaux, cadres, images, ob-
jets OLE, sections, titres, repères de texte). Vous n’aurez pas la possibilité de lui choisir une 
cible précise (par exemple, une page en particulier dans le document ciblé). En utilisant un 
renvoi, vous aurez bien plus de possibilités ;

• pour créer un hyperlien vers un objet (une image, par exemple) qui affichera une information 
explicite telle que « Figure 6 », vous devez modifier le nom par défaut (« Images6 ») en celui 
qui sera visible dans le document. Il vous est également possible de recourir à la boîte de 
dialogue Hyperlien pour modifier le texte visible dans le document. En revanche, les renvois 
vers des images contenant des légendes automatiques affichent directement un texte expli-
cite. Et si ce dernier ne vous convient pas, vous avez le choix entre plusieurs variantes ;

• si vous sauvegardez un document Writer en HTML, les hyperliens demeureront actifs, mais 
pas les renvois automatiques. Par contre, tant les hyperliens que les renvois automatiques 
resteront actifs si le document est exporté au format PDF.

Utiliser les hyperliens

Reportez-vous au chapitre 12, Créer des pages Web, pour les détails sur la création d’hyperliens 
internes à un document et vers d’autres documents ou sites web.
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Créer et utiliser des renvois

Après la création d’un renvoi, appuyez sur F9 pour mettre à jour toutes les références de façon 
que les termes et numéros de page convenables soient bien affichés. 

L’onglet Renvoi de la boîte de dialogue Champs propose quelques éléments tels que Titres, Para-
graphes numérotés, Figures, Tableaux, Repères de texte. Vous pouvez aussi créer vos propres 
éléments de référence : voyez « Définir des références » au Chapitre 17, Travailler avec les 
champs du Guide Writer pour toute information.

Pour insérer un renvoi vers un titre, une figure ou d’autres éléments affichés dans l’onglet Renvois 
de la boîte de dialogue Champs procédez de la manière suivante :

Figure 33. L’onglet Renvois de la boîte de dialogue Champs.

 1) Dans le document, placez le curseur à l’endroit où vous souhaitez que le renvoi apparaisse.

 2) Si la boîte de dialogue Champs n’est pas ouverte, sélectionnez Insertion > Renvoi dans la 
barre de menu ou appuyez sur les touches Ctrl+F2 de votre clavier. Dans l’onglet Renvois 
(voir Figure 33), cliquez dans la liste Type sur le type d’élément que vous souhaitez référen-
cer (par exemple, Titre ou Figure).
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Vous pouvez laisser cette boîte de dialogue ouverte pendant que vous insérez plusieurs ren-
vois.

 3) Cliquez sur l’élément requis dans la liste Sélection qui affiche automatiquement les entrées 
créées (par exemple, les titres du document), ainsi que les références définies par l’utilisa-
teur (par exemple, les repères de texte).

 4) Dans la liste Insérer une référence à, choisissez le type de référence que vous souhaitez. 
Les possibilités varient en fonction de l’élément référencé.

Pour les titres, vous choisirez probablement Référence (pour insérer le texte complet du titre)
ou Page (pour insérer le numéro de page sur laquelle apparaît le titre).

Pour les figures, vous choisirez probablement Catégorie et numéro (pour insérer le mot Fi-
gure et son numéro), Référence (pour insérer le mot Figure avec son numéro et le texte 
complet de la légende), Page (pour insérer le numéro de page sur laquelle se trouve la fi-
gure), ou Numéro (pour insérer uniquement le numéro de la figure).

 5) Cliquez sur le bouton Insérer.

Utiliser les repères de texte

Les repères de texte sont répertoriés dans le navigateur et y sont directement accessibles en un 
clic de souris. Dans les documents HTML, les repères de texte sont convertis en ancres acces-
sibles à l’aide des hyperliens. Pour créer un repère de texte, procédez de la façon suivante :

 1) Sélectionnez le texte que vous souhaitez définir comme un repère. Choisissez Insertion > 
Repère de texte… dans la barre de menu.

 2) Dans la boîte de dialogue Repères de texte, la zone la plus large répertorie les repères pré-
cédemment définis. Saisissez un nom de repère dans la zone supérieure de la boîte de dia-
logue. Cliquez sur le bouton Insérer pour valider.

Figure 34. Insérer un repère de texte.

Utiliser des documents maîtres

Les documents maîtres sont habituellement utilisés pour produire des longs documents (un livre, 
une thèse ou un rapport conséquent) ou dans le cas où plusieurs personnes rédigent différentes 
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parties du document, ce qui évite de transmettre celui-ci de l’un à l’autre. Un document maître re-
groupe des documents textes séparés en un seul grand document, unifie le formatage, la table des
matières, la bibliographie, l’index, les tableaux ou les listes. Pour plus de détails sur l’utilisation des
documents maîtres, reportez-vous au chapitre 16, Les documents maîtres, du Guide Writer.

Des modèles de documents maîtres peuvent être ajoutés au Gestionnaire de modèles de la même
façon que les modèles ordinaires. Ainsi, depuis un modèle de document maître, il est possible de 
créer un nouveau document maître contenant les paramètres initiaux dudit modèle. Pour plus d’in-
formations sur la création et l’utilisation des modèles, référez-vous au chapitre 10, Travailler avec 
les modèles, du Guide Writer.

Classifier le contenu des documents

La classification et la sécurité des documents sont importantes pour les entreprises et les gouver-
nements. Quand des informations sensibles sont échangées entre utilisateurs et organisations, les
parties se mettent d’accord sur la façon d’identifier et de gérer de telles informations. LibreOffice 
offre des moyens standardisés pour identifier et protéger les informations sensibles : un ensemble 
de champs standard qui permet de noter le niveau de sensibilité de l’information.

LibreOffice a implémenté le standard ouvert produit par TSCP (Transglobal Secure Collaboration 
Participation, Inc.) indépendant d’un vendeur particulier. Il contient trois catégories BAF (Business 
Authentification Framework : Cadre d’Authentification pour l’Entreprise) : propriété intellectuelle, 
sécurité nationale et contrôle à l’export. Chaque catégorie possède quatre niveaux BAILS (Busi-
ness Authorization Identification and Labeling Scheme : Schéma d’Autorisation, d’Identification et 
d’Étiquetage pour l’Entreprise) : public, professionnel, confidentiel et exclusivement en interne.

Pour activer la classification du document, ouvrez la barre d’outils Classification (Affichage > 
Barres d’outils > Classification). Celle-ci contient des listes déroulantes qui vous aideront à choi-
sir le niveau de sécurité du document. LibreOffice ajoutera ensuite des champs personnalisés aux 
propriétés du document (Fichier > Propriétés, onglet Propriétés personnalisées) pour enregistrer 
la politique de classification dans les métadonnées du document.

Pour prévenir une rupture de la politique de sécurité, les contenus possédant un niveau de classifi-
cation plus élevé ne peuvent pas être collés dans des documents possédant un niveau de classifi-
cation plus faible.

Pour plus d’informations, reportez-vous à l’Aide ou au Chapitre 17, Travailler avec les champs, 
dans le Guide Writer.

Créer des formulaires

Dans un document ordinaire, tel qu’un rapport, tout le texte peut être modifié. Un formulaire est, au
contraire, composé de sections qui ne sont pas éditables ainsi que d’autres sections qui sont desti-
nées à être remplies par le lecteur. Par exemple, un questionnaire comporte une introduction et 
des questions (qui ne changent pas) et des espaces réservés aux réponses du lecteur.

Les formulaires sont utilisés de trois manières :

• pour créer un document simple que le destinataire doit compléter, comme un questionnaire 
envoyé à un groupe de personnes qui le complètent et le retournent à l’expéditeur ;
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• une fois lié à une base ou une source de données, pour permettre à l’utilisateur de saisir des 
informations. Par exemple, quelqu’un qui s’occupe des commandes de clients saisira des in-
formations pour chaque commande dans une base de données à l’aide d’un formulaire ;

• pour visualiser des informations gérées par une base de données ou une source de don-
nées. Par exemple, un bibliothécaire peut obtenir des informations à propos d’un livre grâce 
à cette base de données.

LibreOffice propose plusieurs façons de compléter des informations dans un formulaire, que ce 
soit via des cases à cocher, des boutons d’option, des zones de texte, des listes déroulantes, des 
compteurs, etc. Toutes ces possibilités sont abordées dans le chapitre 18, Utiliser des formulaires, 
du Guide Writer.
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